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Introduction Letter 

Don’t Wait! 
Ask us! 

This is your training 
time and we want you 
to get the most from 
it. 

If you have a question, 
please do not hesitate 
to ask it right away. 

Our trainers feel 
comfortable taking 
questions as you have 
them. 

Don’t let that question 
you have go unasked! 

Hello & Welcome 

... to the Hayes Software Systems TIPWeb-IM application! 

If you are reading this, you have in your hand what we hope will 
prove to be a very useful training guide as well as a user’s manual 
to assist you in answering the questions you have on a daily basis 
about the functionality of TIPWeb-IM.  

For twenty plus years, Hayes Software Systems has been training 
persons just like you in the use of our software solutions 
for school administrators.  We have made it our business to 
understand the instructional materials issues and challenges you 
face on a daily basis. 

If you are attending one of our hands-on or webcast training 
sessions, you are being led by one of several of our experienced 
training staf.  Our trainers know the TIPWeb-IM program and 
will be able to ofer you real life examples and processes to assist 
you in applying the application to your situation. 

This training manual is divided into three sections: 

1. Need to Know – those topics for which you 
need a basic understanding 
to begin using the TIPWeb-
IM campus application. 

2. Nice to Know – those topics that will further 
enhance your use of TIPWeb-
IM’s more advanced functions. 

3. In the Know – helpful resources to assist 
you in the tracking of your 
instructional materials. 

support.hayessoft.com i TIPWeb-IM Campus Training Manual 
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Trainer Biographies 

DEBBIE DISLER 
Vice President of Customer 
Support and Training 

Since 2006, Debbie has been 
leading the support and training 
teams where she continues to 
seek new and exciting methods of 
delivering training and providing 
awesome customer support. 

Coming to Hayes in 2000 as a 
customer support representative 
and trainer, she brought 15 years 
of experience working for a fast 
growing school district in the 
central Texas area.  While at the 
district, she spent 13 years as a 
district textbook coordinator 
and coordinator of the district’s 
reporting of student, staf and 
financial data to the state 
education agency through the 
Public Education Information 
Management System. 

While employed with the 
school district she purchased and 
implemented district wide, the use 
of the TIP DOS program, moving 
to the TIPWIN program when 
it was launched. She developed 
and conducted hands-on training 
for campus personnel and truly 
believes that training is the key to a 
successful textbook accountability 
program. 

 LINDA ANDREWS 
Professional Services Consultant 
and Trainer 

A native Houstonian, Linda, 
retired after spending 22 years 
with Palestine Independent 
School District. 

Linda started out as Palestine’s 
Curriculum Department Secretary. 
For fifteen years, she was their 
District Textbook Coordinator and 
took a “hands on” approach by 
creating a district-wide Textbook 
Procedures and Policies manual, 
implemented the TIP application, 
training campus personnel, 
presiding over textbook adoption 
procedures, and instituting an 
annual district-wide textbook 
inventory audit. 

She was also very involved 
in the Textbook Coordinators 
Association of Texas at the state 
and region level.  During that time 
she realized how much she enjoyed 
making presentations and helping 
other textbook coordinators. 

Linda is excited to have the 
opportunity to continue her 
passion for assisting textbook 
coordinators with the organization 
and management of textbooks. 

AMY BLASSINGAME 
Professional Services Consultant 
and Trainer 

In January 2015, Amy joined 
Hayes Software Systems as a 
Professional Services Consultant 
and Trainer. Our customers benefi t 
from Amy’s positive attitude, 
natural instructional abilities and 
business education background. 
Her strong communication skills 
and the desire to gear training 
toward the need of the learner 
will result in positive instructional 
experiences. 

Amy’s introduction to Hayes 
Software began in 2007 in a large 
Texas school district. By applying 
sound management principals 
and utilizing TIPWeb-IM to it’s 
fullest, Amy played a key role in 
the reduction of instructional 
material loses as well as training 
development and support. 

In 2012, Amy’s expertise 
became an integral part of the 
district’s implementation of 
the 1:X Student Initiative. Her 
input through planning, policy 
design and instruction provided 
her with valuable insights into 
asset management as applied to 
education and TIPWeb-IT. 

Amy is excited to bring her 
expertise to Hayes Software 
Systems and is committed to doing 
all she can to instruct and assist 
learners in their understanding 
and application of the TIPWeb 
applications. 

Hayes Software Systems ii Ask Our Customer Support Team!  800-495-5993 



 

  

 

SUE HEDRICK 
Professional Services Consultant 
and Trainer 

Sue, originally from West 
Virginia, relocated to Texas 
and used her eight years of 
West Virginia public education 
experience working for a Houston 
area school district. She spent the 
next 24 years working in dif erent 
capacities. The last eight years 
of her career were spent working 
in the textbook department, 
supporting the district textbook 
coordinator.  This role taught 
her about the many facets of 
textbook management. 

Sue has a passion for teaching. 
She became her district’s TIPWeb-
IM trainer and, each year that a 
new campus opened, she would 
help campus textbook staf setup 
their new textbook storage rooms 
and teach textbook accountability 
best practice policies. 

In December of 2010, Sue 
chose to retire to join the Hayes 
Software Systems training team to 
continue doing more of what she 
truly enjoys, helping individuals 
achieve success in their role as 
a textbook coordinator.  She is 
excited to ofer her experience 
with technology tools and 
textbook process and procedures 
to help each and every learner to 
achieve a high level of comfort 
with TIPWeb-IM. 

support.hayessoft.com iii TIPWeb-IM Campus Training Manual 
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What is a 
Database? 

A database is a 
collection of data 
needed to support and 
record your day-to-day 
business transactions. 

In the case of 
textbooks that 
includes instructional 
materials received 
by a campus and 
the distributions to 
students and teachers. 

What is a Centralized 
Database? 

A common data repository or warehouse, 
such as a server computer, which includes 
data collected from all common entities 
and all relationships. 

This means - one server located at the 
district level is keeping the instructional 
material data for every campus in the 
district as well as the district level data. 
Access to specific data is dependent upon 
the rights assigned to the user name and 
password for each individual. In the case 
of instructional materials, this means that 
each campus will only be able to see their 
data. 

For TIPWeb-IM, the database is located 
on an SQL Server. 

How does it help me? 

• Utilization of resources are more ef  cient 

• All processing to support the database
system is done at the central computer 

• Eliminates the need for most 
documentation 

• Allows for sharing of data across
campuses and the district 

• Allows access to data from any 
computer in the district 

• As soon as a transaction is processed at
any campus or at the district, it is visible 
to the appropriate TIPWeb-IM user(s). 

B 
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Home Page: Introduction 

TIPWeb-IM Home Screen 

Home page  displays the alerts, customer 
support email, and the TIPWeb-IM Community
Portal. 

Textbooks page  displays the Textbooks
main screen which is where your school’s 
textbooks/other materials can be viewed and/or
added. 

Students page  displays the Students 
main screen, where you manage information 
pertaining to your students. 

Teachers page  displays the Teachers
main screen, where you manage information 
pertaining to your teachers. 

Find A Book page  allows searching your
data by Accession, ISBN, Title, SLC, and by 
Accession (district wide). 

Inventory page  displays the Inventory 
menu screen which has three major components: 
Orders, Adjustments, and Transfers. 

Help icon  displays the 
online TIPWeb-IM Help
System which is context-
sensitive. If you are on
a particular page within
TIPWeb-IM, it opens 
the help file linked to the 
respective page you are on. 

Log Out icon  logs
you out of the TIPWeb-IM 
session. 

Automation page  is where you will
manage information pertaining to bar codes 
and scanning: manage your PDA fi les, perform 
distributions and collections using quick data
entry, and print ISBN and accession bar code
labels. 

Reports page  displays the reports available 
for printing by category. 

Other Data page  displays the Other Data
menu screen consisting of Vendor/Publishers,
Courses, and Archives. 

Tools page  displays the Tools menu screen 
which has two major components: Textbook 
Tools and Global Tools. 

Support Center button 
opens the Hayes Support Center.  

 
 

  
 

 

 

  

  

 

 

  

 
 
 

 

  
 

 

 

 

 
 

 
 

 

  

  

You can access 
videos, documents, TIPWeb-IM enhancement 
notes, and step-by-step instructions on how best
to use TIPWeb-IM. 

Hayes Software Systems 2 Ask Our Customer Support Team!  800-495-5993 
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Alerts 

Under the Alerts area of the Home page, 
you are provided with alerts regarding 
inventory statuses and procedures which 
require your attention. 

Click on any red alert, and you will be taken 
to the respective area of TIPWeb-IM. 

Application 
Notification 

This is a message from your district 
instructional materials ofce.  The fi rst time 
this message is sent out, it will automatically 
pop up on your screen.  After that, it will 
be available to you under Application 
Notifi cation. 

Inventory Statistics 

This is a real time display of the campus 
inventory statistics with counts and dollar 
values for Total Inventory (includes district 
tracked and campus owned materials), 
Storage (materials not distributed 
to individuals), Lost, and Payment 
instructional materials.  The Payment 
material values included distributions in the 
status of Paid and/or Partial paid. 

Customer Support 

If you have questions not addressed in the 
online help, or need customer support, click 
on Email Support or call us toll free at 
1-800-495-5993. 

Did You 
Know? 

TIPWeb-IM customers 
have UNLIMITED 
technical support. 

This means our 
customer support 
team will continue to 
work with you until 
your issue has been 
resolved. 

So, don’t worry about 
contacting us!  We 
want to help you with 
your questions. 

B 
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Hayes Support Center 

The Hayes Support Center is located at support.hayessoft.com . 

You will be able to access important and helpful TIPWeb-IM information, such as: 
•  News •  Enhancements •  Step-by-Step Instructions 
•  Training Opportunities •  Training Videos •  Documents & Downloads 

Hayes Software Systems 4 Ask Our Customer Support Team!  800-495-5993 
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TIPWeb-IM Help Screen 

The Help icon  is located in the upper right-hand corner of almost 
every screen within the TIPWeb-IM program. 

The Help System opens to the content specific to the screen you are 
on when you select the Help icon.  It also has detailed step-by-step 
instructions and videos to help you master the various concepts of the 
application. 

support.hayessoft.com 5 TIPWeb-IM Campus Training Manual 
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Practice Activity 
In pairs or in small groups, read the following scenarios and answer the questions. 

1. Circle the icon you would select to order items from your district of  ce: 

2. Circle the icon you would select to research how to use an area of TIPWeb-IM: 

3. Circle the icon you would select to find out what homeroom a teacher belongs to: 

4. Circle the icon you would select to print bar code labels for your instructional materials: 

5. Circle the icon you would NOT select to issue instructional materials to teachers: 

6. Circle the icon you would NOT select to review which items a specific student has issued to them: 

Hayes Software Systems 6 Ask Our Customer Support Team!  800-495-5993 
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We will introduce you to the specific meaning of all icons you will use in 
each area of TIPWeb-IM.  However, many icons appear frequently and the 
following are the most common icons you will be interacting with: 

Previous Page - returns you to the previous screen.  Use 
this TIPWeb-IM icon and NOT the 
browser’s back button. 

Next Page - sends you to the next screen.  Use this 
TIPWeb-IM icon and NOT the browser’s next 
button. 

Cancel - cancels the chosen function and/or returns you to 
the previous screen. 

Search - engages the search function - generally after you 
enter specific data into the search fi eld. 

Refresh - refreshes the TIPWeb-IM area and returns the 
current screen to it’s original state. 

Print Report - opens a PDF version of the data you wish 
to view.  You will have the option to view, 
save and/or print the respective data. 

Details - produces more detailed information regarding 
the item/person it is in reference to. 

Edit - opens the selected item/person/area to edit any 
applicable data. 

support.hayessoft.com 7 TIPWeb-IM Campus Training Manual 
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Save - saves selected information to be accessed at a 
later time. 

Add - generally adds something in regards to the 
TIPWeb-IM area you are in. 

Delete - generally removes data from the TIPWeb-IM 
database or inactivates the data.

  Blue Grid Headers are clickable and will sort the grid’s 
content (ascending or descending) 
by the grid header item you select. 

Did you 
know? 

Depending on the area of 
TIPWeb-IM you are working 
in, several of the commonly 
seen icons take on dif erent 
roles. 

They perform the same 
general role, however, it will 
be “tweaked” to be pertinent 
to the area you are working 
in. 

The Add icon is a great 
example.  In the Textbook 
area, the Add icon will allow 
you to add a new campus 
owned instructional material 
to the database. 

Yet, in the Orders area, after 
creating the order, the Add 
icon allows you to add a 
current instructional material 
to the specifi c order. 

If you have questions about 
any TIPWeb-IM area, 
contact our Customer 
Support Team. They 
will happily help walk you 
through it. 

Hayes Software Systems 8 Ask Our Customer Support Team!  800-495-5993 
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Overview 

The Tools area consists of two major components: 

• Textbook Tools allows you to make specific district and campus 
customizations for the instructional materials distributed and 
tracked within your district and/or campus. 

• Global Tools allows you to make TIPWeb-IM changes for your 
campus version of TIPWeb-IM.  The changes you make within 
this area only afect your campus’ TIPWeb-IM settings (not your 
entire district’s TIPWeb-IM settings). 

Tools Screen 

Textbook Tools Global Tools 

See the Nice To Know section User Management  Add/edit campus users. 
of this training manual. 

Form Letter Editor  Create, edit, and 
personalize form letters. 

Closing  This option provides all the steps 
needed to close out an academic year or term. 

support.hayessoft.com 9 TIPWeb-IM Campus Training Manual 
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User Management  is used to add, edit, and delete information 

User Management Screen 

Tools - User Mgmt: Introduction 

about the staf allowed to use TIPWeb-IM on your campus. 

There are two diferent groups to which a user can be assigned: 
Administrator or User. 

• The Administrators group allows the user to delete items in
the database and add additional users. 

• The Users group allows the user access to TIPWeb-IM.
However, the user cannot delete instructional materials 
from the database, cannot assign additional users, nor  
have access to TIPWeb-IM’s Closing features. 

The username and password are case sensitive. 

For security purposes, Hayes Software Systems suggests updating
passwords once a year on all user accounts. 

Did You 
know? 

Your district’s 
TIPWeb-IM 
coordinator adds the 
primary user account 
for your campus. 

The primary campus 
user adds additional 
campus users. 
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Add / Edit 

To ADD a New Campus User: 

1. Click on (Tools) located on the Navigation Bar. 

2. Under Global Tools, click on (User Management). 

3. Click on (Add). 

4. Enter the name of the user. 

5. Assign a user name and a password. 

6. Select a group, either Administrator or User. 

7. After you have entered all user information, click on (Save). 

To EDIT a Campus User: 

1. Click on (Tools) located on the Navigation Bar. 

2. Under Global Tools, click on (User Management). 

3. Click on (Edit) located in the row in which the user is listed. 

4. Make the changes in the Name, Username, Password, or 
Group fi elds. 

5. When you are finished editing, click on (Save). 
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Overview 

Tools:  Form Letter Editor 

Did you 
know? 

You cannot print the 
letters for students 
from the Form Letter 
Editor, you can only 
create, edit, and store 
the letters. To print a 
letter, you must click 
on Reports in the 
Navigation Bar and 
select the Form Letters 
subcategory from the 
drop-down menu. 

Book Status is the 
most common fi lter 
applied for Form 
Letters. 

Such as, a lost book 
form letter is created in 
the Form Letter Editor. 
Under the Reports 
area in TIPWeb-IM, 
the letter is selected 
and the fi lter assigned 
to this letter is for any 
LOST book status.  This 
creates a letter for each 
person who has a LOST 
book status within their 
account. 

The Form Letter Editor allows you to create, edit, and store form 
letter templates to assist you in getting payment for lost instructional 
materials or getting those materials back, or notifying students/ 
parents of instructional materials policies. 

These are letters which provide important information to parents, and 
students regarding lost items, fines, the end of the year policies, and/or 
returning items before the last day of school/graduation. 

Below is the default letter in English which comes with TIPWeb-IM: 

When a student leaves school, all textbooks and materials must be returned to the school or purchased

by the parent or guardian at current prices. Your child failed to return the textbook(s) listed above.

If the textbooks are lost or not available, as parent/guardian you must pay for the missing books in the

amount stated above. Please call us if you want to make payment arrangements. We can set up a 

payment schedule for you. If the books are returned, payment is received, or satisfactory payment

arrangements are made within the next ten (10) days, no further collection action will be taken.

Failure to return these textbooks or pay the amount due may lead to disciplinary action or legal action,

whichever is appropriate. Please help us remove this debt from your record. Return the textbooks to

the school office (or to the District Office), or call us to make payment arrangements. Payments may 

be made directly to the school or District Office.

If you have any questions about this letter please contact me. 

Sincerely yours, 

Dear Parent or Guardian of 

Joe Sample 

1234 Elm Street 

Sample City,  MA  02468 

0192835750

673623483

0205084370 

The Three Musketeers

Scott Foresman Reading

Myths And Their Meaning 

$10.30 

$62.00 

$18.10 

456 

122 

85 

TOTAL: $90.40 

ISBN

Title
Accession Type Price 

LOST 

LOST 

LOST 
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Form Letter Editor Screen 

Edit icon  allows alterations 
and/or additions to the form letter.  
If you edit a TIPWeb-IM default 
letter or a district created letter, 
TIPWeb-IM will require you to 
rename the letter.  You are not 
permitted to alter the originals as
they need to be available for other 
users. 

Preview icon  opens a PDF of a 
sample of the respective letter and 
some sample data. 

Delete icon  will delete any 
campus created form letter.  The 
original TIPWeb-IM default letters 
and any letters created by your
district cannot be deleted. 
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Form Letter Editor: Step by Step 

Create a New Form Letter 

1. Click on (Tools) located on the Navigation Bar. 

2. Under Global Tools subcategory, click on Form Letter Editor. 

3. To create a new form letter, click on (Add). 

4. Give the letter a Name. 

5. Enter a brief description for the letter you are creating. 

6. Write the body of the letter. 

7. Click on (Save). 

Edit a Form Letter 

1. Click on (Tools) located on the Navigation Bar. 

2. Under Global Tools subcategory, click on Form Letter Editor. 

3. To edit a form letter, click on (Edit). 

4. Change/add any part of the form letter (including the name, 
description, and body of text). 

5. To save click on (Save). 

Print a Form Letter 

1. Click on (Reports) located on the Navigation Bar. 

2. In the drop-down menu, select Form Letters. 

3. Find the form letter you want to print and click on  (Filter) in
the row listing the form letter. 

4. Filter for the students to whom you want to send this letter and 
the status you want displayed. 

5. To print this report, click on  (Report). 

Did you 
know? 

Hayes Software Systems 
suggests you compose the 
body of your letter in a 
word processing program - 
like MS Word.  

In that program, run a spell 
check and/or grammar 
check to eliminate as many 
human errors within your 
letter as possible. 

Then copy and paste the 
letter into TIPWeb-IM. 
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Textbooks 

Overview 

Textbooks is where textbooks or other materials can be viewed 
and/or added to the TIPWeb-IM database. 

Selecting this icon will produce a list of items that can be limited by I 
search criteria you select. 

Click on a specific title to display: 
• The total number of items in inventory 
• The number of items issued 
• The number of items currently in storage 

Textbooks can also be distributed from this icon. 

TIPWeb-IM’s Alphabet Soup 

Within TIPWeb-IM, you will find many acronyms and abbreviations.  The 
following have been defined for you: 

ISBN - International Standard Book Number: This is the 10 or 13 digit 
number assigned by the publisher of each book title. 

SLC - State List Code - Some states assign numbers to groups of
instructional materials. 

CLTD - collected - a returned item. 

DIST - distributed - an item in use by a student or teacher. 

DSTY - destroyed - an item identified as Hazardous, Flood Damaged, 
Stolen, etc. No payment is expected and the item is unusable. 

LOST - temporary status, waiting for payment or for the item to be found. 

PAID - payment has been received for the FULL amount of an item. 

PRTL - partial payment - This indicates a partial payment for an item. It is a 
temporary status which should result in full payment. 

XFER - transfer - only seen on teacher distributions and designates an item 
was transferred from the respective teacher to another individual. 
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Textbooks Screen 

Textbooks: Introduction 

Details icon  displays the textbook 
detail screen (see next page). This page
displays the textbooks’ publishing
information, inventory summary,
components, material type, and courses 
assigned to it. 

Distribute icon  performs textbook 
distribution to a student or a teacher. 

Paging feature 
at the bottom of the list, as shown in 
the screen capture above.  It improves
response time and allows you to easily 
navigate through the list. 

Click on the item’s title to display, on
the lower half of this screen, the total 
number of items in inventory, number of
items issued, and the number of items 
currently in storage. 
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Textbooks Details Screen 

Inventory Tab - The quantity of the 
item marked lost, destroyed, paid or
partially paid is displayed along with
total inventory, quantity distributed and 
in storage.  Eligible quantity of this item 
based on enrollment attached to the 
item is displayed.  Information pertaining
to materials for which you have paid the 
district is displayed under Reconciled
Totals. 

Components Tab - A list of all the 
pieces that come with an instructional 
material (such as: workbooks, CDs,
atlases, etc.) 

Material Type - Designates what type 
of material the item is (such as: student
edition, consumable, large type, etc.) 

Courses Tab - Create relationships 
between the instructional material 
and the courses using the instructional 
material.  Eligible enrollment and the 
Class Roster Book Check report are 
dependent upon this relationship. 
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Add / Edit 

To ADD a New Campus Owned Textbook: 

1. Click on (Textbooks) located on the Navigation Bar. 

2. Click on (Add). 

3. Enter a valid ISBN number, and click on (Validate 
ISBN), to ensure this item is not already part of your 
inventory or the district’s inventory. 
(If the item is being tracked by the district, you will need to contact your 
district coordinator to be approved to use this item. If another campus has
already added this item to their campus inventory, you receive a message 
asking if you would like to add it to your campus inventory.) 

4. Enter instructional material information in the fi elds 
provided. 
(The mandatory fields are in red.  Hayes Software suggests that you
provide as much information as possible to make your TIPWeb-IM database 
more useful to you.) 

5. Click on (Save). 

To EDIT a Textbook’s Details: 

1. Click on (Textbooks) located on the Navigation Bar. 

2. Search for the item you want to edit. 

3. Click on (Edit) located in the row in which the item is 
listed. 

4. When all edits have been made, click on (Update). 

5. The message “You have successfully updated the 
textbook” appears. 

6. Click on  (Previous Page) to return to the Textbook 
Details page of the instructional material. 

Funding 
Sources? 

A funding source 
denotes “who” funded 
a particular item.  
TIPWeb-IM comes 
with 3 default funding 
sources.  They are: 
General, State, and 
District. 

• Select District, for 
items purchased 
using campus funds. 

• Select General, 
if grant money or
money from special 
areas such as the 
gifted program 
are being used to 
purchase specialized 
items or to fill a need 
not addressed by the 
state. 

• Select State, if you 
get an allotment of
funds from the state 
for the purchase
of materials or the 
state supplies a 
quota of materials 
you can order. 

FYI - You/your district
coordinator can alter these 
default funding sources and/
or add more funding sources. 
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Practice Activity 

In pairs or in small groups read the following scenarios and answer the 
questions. 

1. You want a quick breakdown for a particular textbook giving you 
how many are in inventory, how many are in use, & how many are 
in storage.  Where do you go?  I 

2. In what situation might TIPWeb-IM not allow you to add an item? 

3. Your AP Biology textbook student enrollment counts look “of ”. 
You are sure there are 2 classes of 30 students each using this 
textbook.  Student enrollment shows only 30 students.  Where do 
you go to diagnose the issue and how do you “fix the problem”? 
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Inventory 

Overview 

The Inventory area provides you with the tools you need to process all your: 

Orders 

An Order is a process that increases the quantity of an item in your inventory. The Orders 
area is divided into two subcategories: 

• Campus Requisitions allow you to create, edit, submit, and receive instructional 
materials from the district. 

• Vendor Orders allow you to create, edit, receive, and track campus owned items 
purchased from an outside vendor using campus/district funds. 

Adjustments 

An Adjustment is a process that typically reduces your inventory and, in some cases, 
increases your inventory.  The Adjustments area is divided into two subcategories: 

• Adjustment Requests allow you to create, edit, and print your adjustment requests 
to the district. To complete the process of an adjustment request, you need to submit 
your adjustment request to the district. 

• Local Adjustments allow you to create, edit, post, and print local adjustments of 
your campus owned inventory. 

Transfers 

The Transfers area allows you to perform campus-to-campus transfers, assuming your
district has set the permissions for your campus to do so.  The term campus-to-campus 
transfer means that you can: 

• Request items from another campus 
• Send items to another campus 
• Receive items from another campus 
• Edit a campus transfer 
• Accept or deny a transfer request from another campus 

Audits 

The Audits area allows you to complete district requested audits of your campus’ district 
tracked inventory.  You have the ability to enter counts, submit your audit to the district 
electronically, and print a report of the audit. 
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Orders: Campus Requisitions 

Overview 

Campus Requisitions can be placed by the campus or the district to 
order/requisition items supplied by the district. The district tracks all 
campus requisitions. 

When a district ships items on a campus requisition (all or a portion) it 
will ship with a Pick Ticket. The Pick Ticket serves as a pick list for 
warehouse staf as well as a packing slip for campus staf . 

If the district ships an item on two diferent pick tickets, those two 
shipments display separately under the tab. This means that the 
campus is able to receive each shipment separately according to the 
ticket amount or as a whole. 

While in the Campus Requisition area, you can perform the following 
tasks:

 • Create a campus requisition (tracked by the district)
 • Submit a campus requisition
 • Edit a campus requisition 
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• Receive a campus requisition 
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Campus Requisitions Introduction 

Campus Requisitions Screen 

Grid Header is clickable and will sort your campus
requisitions (ascending or descending) by the menu
item you select.  Available menu bar items to sort 
by are:  requisition name, date created, and status. 

Receive icon  opens the respective campus
requisition and allows the campus to receive the 
shipment the district warehouse put into transit. 

Show Completed check box 
allows you to view campus requisitions for which all 
items have been received/denied and the status of
the requisition is Complete.  

Hayes Software Systems 22 Ask Our Customer Support Team!  800-495-5993 



 

 

 

 

 

Campus Requisition Detail Screen 

Campus Requisition Status -
indicates the overall status of your
requisition. 

Notes - a place to make notes 
to yourself and/or to your district
coordinator regarding the items 
within this campus requisition. 
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Title Status - indicates the 
actual status of each item in your
requisition. 

Did you know? 

A campus requisition can be named anything which has not been 
used before. 

However, most districts have naming conventions they would like
you to follow.  One common naming convention is” 

[YY] [Campus #] [MMDD] 

Please ask your district coordinator if your district is using a naming
convention for campus requisitions. 
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Campus Requisition Statuses 

There are two important kind of statuses in a campus requisition.
 The Campus Requisition Status indicates the overall status, 
 The Item Status indicates the actual status of each item in your requisition.  

The following is a complete list of the possible Campus Requisition Statuses and Line Item Status within 
each Campus Requisition Status: 

► NEW - The campus created the campus requisition 
and has not submitted it to the district. 

Pending - You were interrupted while creating
the requisition.  You saved the requisition so
that you could finish adding the needed items 
before submitting to the district. 

► IN TRANSIT -

The district ofce is shipping at least one of the items 
within the campus requisition.  You are awaiting the 
arrival and will need to verify and receive the shipment. 

In Transit - The district ofce has shipped the 
approved quantity of the respective item.

 Submitted - You are waiting for the district
level to approve the quantity of an item.► SUBMITTED - The district level created the 

campus requisition or the campus
created and submitted the campus
requisition to the district of  ce. You 
are waiting for the district level to 

 Approved - The district level has approved the 
quantity listed for the respective item (this may 
be less than the original copies requested). 

approve. 

Submitted - Your requisition has been 
submitted to the district ofce for approval.  

Ticketed - The district level has printed a pick
ticket for warehouse personnel to pull and ship
the approved quantity of the respective item.

 Denied* - Your request for the item has been 
denied; no copies will be approved/shipped. ► IN PROGRESS -

The district ofce is in the process of reviewing the 
requisition and printing pick tickets for approved
item(s). You are waiting for the district level to 
change the status to In Transit.

 Approved - The district level has approved the 
quantity listed for the respective item (this may 
be less than the original copies requested).  You 
are waiting for the district ofce to ship the 
approved quantity. 

Ticketed - The district level has printed a pick
ticket for warehouse personnel to pull and ship
the approved quantity of the respective item(s). 

Submitted - You are waiting for the district
level to approve the quantity of an item.

 Denied* - Your request for the item has been 
denied; no copies will be approved or shipped. 

► COMPLETE - The district ofce has shipped and/
or denied all item(s) on your campus
requisition. Your campus has verifi ed
and received the shipment. 

Completed - The district of  ce has shipped 
all the approved item(s), of your campus
requisition. Your campus verified and received
the shipment.

 Denied* - Your request for the item has been 
denied; no copies will be approved/shipped. 

*If an ISBN is denied by the district, there may be a note
from the district as to why the title was denied located on
the Campus Requisition Details screen (green tool tip), the 
Pick Ticket, and the Campus Requisition Report. 
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Campus Requisition Status 

Item Status 

support.hayessoft.com 25 TIPWeb-IM Campus Training Manual 

https://support.hayessoft.com


 

  

 
 

  
 

 
  

    

  

    
 

 

 
 

 
 

 
 

Create a New Campus Requisition 

When you need to order instructional materials from the district, you 
make a request to the district by creating a Campus Requisition. 

Campus Requisition: Step-By-Step 

1. Click on (Inventory) located on the Navigation Bar. 

2. Under the Orders subcategory, select Campus Requisitions. 

3. Click on (Add Req For Campus) to start a new requisition. 

4. Enter a name for the requisition in the Requisition Name fi eld. 

5. Click on (Validate Campus Requisition Name). 

3

4 5

Did you 
know? 

Once an order is 
(Submitted) to the district 
you CANNOT make 
changes to the order. 

If you think you might 
want to add or edit the 
order before you submit 
it to the district, click on

 (Save/Exit) without 
submitting to the district. 

This gives you the 
opportunity to: 

•  (Add) additional 
instructional materials, 

•  (Edit), 

• and/or  (Delete) 
the current items on 
the requisition at a later 
time. 

However, if you have 
already submitted your 
requisition to the district 
and you suddenly realize 
that you have made a 
mistake, you can contact 
your district administrator 
to make the appropriate 
changes for you. 
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6. Use Search to find an item you want to add to the requisition. 

7. Click on the title of the item. The row highlights to orange. 

8. Verify the Copies Needed field and use this number to help you 
calculate your Copies to Order. Enter the quantity you wish to 
order in the Copies to Order fi eld. 

I9. Click on (Add Textbook to Requisition) 

10. Verify that the quantity you entered is correct for the title listed 
at the bottom of the page. 

11. To add multiple titles to this requisition, repeat steps 6 through 
10 until all desired instructional materials have been added. 

12. Once the order is complete and you are ready to submit it to the 
district of  ce, click on (Submit). 
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12
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8
9
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Receive a Campus Requisition 

A campus requisition can only be received if the status of the item(s) is In 
Transit.  The district ofce may set a policy establishing the number of days
a campus has to receive shipped items.  After the time limit has expired, the 
district may receive the shipment on behalf of the campus.  This is done to 
keep the TIPWeb-IM database up-to-date. 

1. Open the shipment and physically count the items to confi rm the 
quantity and items match the Pick Ticket (from district) included
with the shipment. 

IMPORTANT:  Contact the district coordinator PRIOR to 
receiving a requisition with quantity discrepancies. 

2. Click on (Inventory) on the Navigation Bar. 

3. Under the Orders section, click on Campus Requisitions. 

4. Use Search to find the requisition you want to receive. 

5. Verify the physical count corresponds to the amount shipped on 
the Pick Ticket. 

IMPORTANT:  Contact the district coordinator PRIOR to 
receiving a requisition with quantity discrepancies. 

6. If it is the same, click on (Receive) in the row corresponding 
to the item you want to receive.

 OR 
If all items on the order have arrived as shipped, simply click on 

(Receive All). This receives all items on the requisition at the 
quantity shipped. 

7.   Click on (Previous Page) to return to the Campus 

Requisitions page. 

Did you 
know? 

On the TIPWeb-IM Home 
page, you can also receive 
a campus requisition by 
clicking on In Transit 
Requisitions under the 
Alerts category. 

What if this 
happens? 

If there is a discrepancy 
between the quantity of
items on the order and the 
actual number of items 
received, contact the 
district coordinator. 

The Campus Requisition 
remains with a status of 
In Progress or In Transit 
until all items are received 
in full. Once all items are 
received on the Campus
Requisition, the status
changes to Complete. 
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  Inventory: Adjustments 

Overview 

An Adjustment is an important process which reduces or increases the 
total quantity of items in your instructional material inventory. IThere are two kinds of adjustments: 
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Adjustment Requests are used to report surplus instructional 
materials to be returned to the district’s 
inventory or items that are destroyed, worn, 
or paid for. These requests are subject to the 
district’s approval. 

Local Adjustments are adjustments of campus owned items or 
instructional materials not tracked by the 
district. 

support.hayessoft.com 29 TIPWeb-IM Campus Training Manual 

https://support.hayessoft.com


 
 

     
     
     

     

 

 

  

 

  

 

 

 

 
  

 

  

 
 

 

 
 

 

 

 
 

Adjustments: Adjustment Requests 

Overview 

Adjustment Requests are used by the campus or district level to 
decrease or increase the inventory of items or instructional materials at
the campus level that are tracked by the District. 

Decreases in inventory may be due to: 
• the payment of instructional materials by students/teachers, 
• surplus instructional materials due to a decrease in students, 
• instructional materials destroyed in a fi re, flood or other 

natural disaster, 
• instructional materials which are worn out (coming apart due 

to wear, not abuse) 

Increases  in inventory due to found instructional materials previously 
paid for by the campus are processed by a Found 
Adjustment, which is automatically created when a 
reconciled item is returned to storage.  Once the adjustment
is posted the inventory at the campus level will increase.  The 
adjustment will automatically reflect the increase at the district
level as well. 

There are five adjustment types: 

Return Surplus: Your campus has too many copies and is
returning the surplus. 

Destroyed: Your campus is declaring an item has been 
destroyed. 

Worn: Your campus is declaring an item is worn. 

Paid: Your campus is declaring an item has been paid for in full. 

Found - Your campus found instructional materials currently 
in adoption which the campus previously paid for.
This type of adjustment can also be used to increase
inventory which was never recognized by the district.  
(This is useful during the initial conversion to TIPWeb-
IM.) 

Did you 
know? 

Adjustment requests
can be named anything
which has not been used 
before. 

However, most 
districts have naming
conventions they would 
like you to follow.  The 
most common naming
convention is 

[YY] [Campus #] 
[MMDD] 

Please ask your district
coordinator if your
district is using a 
naming convention for 
adjustment requests. 
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Adjustment Requests Screen 

Adjustment Requests Introduction 

Show Completed check box 
 allows you to 

view all adjustment requests with a 
status of “Completed”. 

Status - indicates the overall 
status of your adjustment request. 

Description - a place to make
notes to yourself and/or to your
district coordinator regarding 
the items within this adjustment 
request. 
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Create a New Adjustment Request 

1. Click on (Inventory) on the Navigation Bar. 

Adjustment Requests: Step-By-Step 

2. Under the Adjustments subcategory, click on 
Adjustments. (The Adjustments page opens with the 
Adjustments Requests tab already selected.) 

3. Click on (Add). 

3

2

4. Select an adjustment type from the Adjustment Type 
drop-down menu. 

5. Name the Adjustment Request. 

6. Click on (Next). 

4
5

6

Did you 
know? 

When your district 
coordinator approves/posts 
your campus’ adjustment 
request, they will print 
a Call Tag if there are 
items they need to pick up 
from your campus - such 
as with Return Surplus 
Adjustment Requests. 

TIPWeb-IM’s Home page 
has an Alerts area where it 
will alert you in red text if an 
Adjustment Call Tag has 
been printed by the district 
coordinator for your campus. 

To see the sample Call Tag 
below in more detail look in 
the In the Know area of this 
training manual. 

Pick Up From 
Ship To 

Dixon Elementary
i W y 

Shawn Carlson
512-219-7906
Austin TX 78726
11910 Volente Rd
Learning ISD 

Jason Long 
512-546-1123 

Campus Name 
Adjustment Name 

Created By Type 

Dixon Elementary EOY Surplus 09 Debbie Disler Return
Surplus 

SLC ISBN 
Title Copies Picked Up Price Amount 

4120 1570395039 

$6.00
5 

$30.00 

EDM Journal 1, Grade 4 

6120 1570395136 

$6.00
3 

$18.00 

EDM Journal 1, Grade 6 

4120 1570395047 

$6.00
5 

$30.00 

EDM Journal 2, Grade 4 

6120 1570395144 

$6.00
3 

$18.00 

EDM Journal 2, Grade 6 

$96.00 

Call Tag 

Campus Signature 
Driver Signature 

Page 1 of 1 

1234 Education Way 

Austin, TX 78726 
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7. If a description is desired, enter it in the Description fi eld 
at the top of the page. 

8. Use Search to find the item you want to adjust. 

9. Click on the title. The row highlights to orange. 

10. Enter a number for the amount of copies you want to 
adjust into the Copies to Adjust text box. The number of 
copies available will be displayed. 

11. Click on (Add). 

12. Repeat steps 9 through 12 until all adjustments are made. 

13. When you are finished, click on  (Save). (You can still 
edit the adjustment at this point). 

14. To send the adjustment request to your district of  ce, click 
on (Submit). 
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9

8

7

10 11
13

14
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Practice Activity 

In pairs or in small groups read the following scenarios and answer the 
questions. 

1. List the steps to create a requisition. 

2. You realize you are going to be LATE for a meeting!  You just 
started a Campus Requisition with five of the nine titles your 
campus needs.  How do you keep from losing all work you 
have done already and assure you can complete your order at 
a later time? 

3. Your bookroom is overflowing with extra books due to a 
reduction in the number of students on campus.  What type 
of adjustment do you create? 
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Orders:  Campus Vendor Orders 

Overview 

A Campus Vendor Order allows you to place an order for items the 
district level is not tracking (such as, dictionaries, graphing calculators 
or technology equipment, which are not supplied by the district). I 
A Campus Vendor Order has two diferent overall statuses: 

Pending - The order has been created and you are awaiting 
shipment arrival. 

Complete - All items have been received in their entirety. 

Item statuses are: 

Pending - You are awaiting the receipt of the instructional 
materials 

In Progress - Some of the items have been received either 
partially or in their entirety. 

Complete - The entire quantity has been received as ordered. 
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Campus Vendor Order  Introduction 

Campus Vendor Order Screen 
Campus Vendor Order Detail Screen 

Grid Header is clickable and will sort 
your campus’ vendor orders (ascending or
descending) by the menu item you select.  
Available menu bar items to sort by are:
vendor order name, date created, status, and 
created by. 

Receive icon  opens the respective
campus vendor order and allows you 
to receive the shipment once you have
physically received the item(s) on campus. 

Show Completed check box 
 allows you to view 

all campus vendor orders with a status of
Complete. 

Status - indicates the overall status of your
campus vendor order. 

Special Instructions - a place to make
notes to yourself and/or to other campus
coworkers regarding the items within this
campus vendor order. 

Did you know? 

A campus vendor order can be named anything that
has not been used before. 

However, most campuses have found implementing a 
naming convention for all campus vendor orders helps. 

A common naming convention is the year and a 
memorable clue word. 

[YY] [CLUE WORD] 
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Create a New Campus Vendor Order 

1. Click on (Inventory) on the Navigation Bar. 

2. Under the Orders section, click on Campus Vendor Orders. 

3. Click on (Add). I
4. Assign a name to this order by entering one into the Name this 

Vendor Order text box (Required). 

5. Select a funding source by using the Funding Source drop-down 
menu (Required). 

6. Click on (Calendar) to select the arrival date (Required). 

7. Enter information, such as, shipping address and contact name 
into the Special Instructions for this Order field, if you have 
special instructions for the vendor. 

8. Fill in the remaining fields with as much information as you 
desire. When done, click on (Next). 

9. Add items you would like to order by searching for the item and 
clicking on it. The row highlights to orange. 

10. Insert the desired quantity in the Copies to Order field. Click on 
(Add). 

11. After you add the quantity for this item, the Textbooks for 
Vendor Order… becomes active (look under the blue bar at 
the bottom of the page). Verify that the quantity you entered is 
correct for the item listed. 

12. Add multiple items, if needed, to this vendor order by repeating 
steps 6 through 10 until all desired items from this vendor order 
have been added. 

13. You can always print a copy of the order by clicking on 
(Print). 

14. Click on (Save). 
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Edit a Campus Vendor Order 
To edit a vendor order, the status of the vendor order must be 
Pending. 

1. From Inventory on the Navigation bar click on Campus 
Vendor Orders section, use Search to find the vendor order 
you want to edit. 

2. Click on (Edit) to change the information. The Edit 
Vendor Orders page displays. 

3. Edit the required information and click on the corresponding 
grid line (Save). 

4. Click on (Save). 

5. Print a copy of the order by clicking on (Print). 

Receive a Campus Vendor Order 
Before you can distribute the newly received vendor ordered 
instructional materials to students or teachers, you have to tell TIPWeb-
IM that the items on order have arrived and what the physical count is. 

1. From Inventory on the Navigation bar click on Campus 
Vendor Orders section, use Search to find the vendor order 
you want to receive. 

2. Verify that your physical count corresponds to the ordered 
amount. If it is the same, click on (Receive) in the row 
corresponding to the item you want to receive.

 OR 
If all items on the order have arrived as ordered, simply click on 

(Receive All). This receives all items on the order at the 
quantity ordered. 

3. If not all items are shipped as ordered or have been back 
ordered, you need to change the number in the Copies column 
to reflect the actual number received. 

Then, click on (Receive) to the right in the same row. 

4.   Click on (Previous Page) to return to the Campus 

Vendor Orders page. 

Funding 
Sources? 
A funding source denotes
“who” funded a particular item.
TIPWeb-IM comes with 3 default 
funding sources.  They are: 
General, State, and District. 

• Select District, for items 
purchased using campus or
district funds. 

• Select General, if grant money 
or money from special areas 
such as the gifted program 
are being used to purchase
specialized items or to fi ll a 
need not addressed by the 
state. 

• Select State, if you get an
allotment of funds directly 
from the state for the 
purchase of books/materials
and the state is holding you 
accountable for the items 
purchased. 

FYI - You/your district coordinator can 
add or edit funding sources. 

Did you know? 
The status of the order remains 
Pending until all items have 
been received in full. 

Once all items are received, the 
status will change to Complete. 

To view all Campus Vendor 
Orders with a status of 
Complete, click on the Show 
Completed check box 

  on the 
main campus vendor orders 
page. 
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  Inventory: Adjustments 

Overview 

An Adjustment is an important process which reduces or increases the 
total quantity of items in your instructional material inventory. IThere are two kinds of adjustments: 
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Adjustment Requests are used to report surplus instructional 
materials to be returned to the district’s 
inventory or for items that are destroyed, 
worn, or paid for. These requests are subject 
to the district’s approval. 

Local Adjustments are adjustments of campus owned items or
instructional materials not tracked by the 
district. 
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Adjustments:  Local Adjustments 

Overview 

A Local Adjustment is used to decrease campus owned instructional 
materials not tracked by the District. The various types of local 
adjustments used to decrease the campus owned inventory are: 

• Worn - items need to be replaced due to normal wear and 
tear. 

•  Destroyed - items destroyed in a fi re, flood, or other natural 
disaster. 

• Shrinkage - a physical count of instructional materials in
the book room reveals a shortage. 

• Paid - the payment of campus owned instructional 
materials by students/teachers. 

•  Return Surplus - your campus received too many copies
from the vendor and is returning the 
surplus. 

The three statuses of local adjustment are: 

•  New - the local adjustment has been created and is ready 
to be posted. 

• In Progress - some of the items within a local adjustment
have been posted. 

• Complete - all items have been posted. 

Did you 
know? 

The term Post or Posted 
applies to the process 
which reduces the campus
owned  inventory of an 
item listed on a local 
adjustment. 

The Complete icon 
is used in the event that 
you do not want to post 
everything on the local 
adjustment. 

For example, you adjust 
10 algebra books, but
before you post them, 
one of the 10 textbooks is 
found. You now want to 
only post 9 textbooks, not
10. 

If any title is not posted 
as entered, such as the 
scenario discussed above, 
the adjustment status will
remain In Progress until 
it is marked Complete. 
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Local Adjustments: Introduction 

Local Adjustment Screens 

Grid Header is clickable and will 
sort your  adjustment requests
(ascending or descending) by the 
menu item you select.  Available 
menu bar items to sort by are:
adjustment name, date created, 
created by, status, and type. 

Show Completed check box 
 allows you to 

view all local adjustments with a 
status of “Completed”. 

Post icon  applies the decrease in
inventory for the respective title. 

Post All icon  applies the decrease in
inventory for all of the titles within the local 
adjustment. 

Complete icon  sets the respective title to 
a status of complete. Use this only if you do
not want to post the item to your inventory 

Description - a place to make notes to 
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yourself and/or to your co-workers regarding 
the items within this local adjustment. 

Adjustment Status - indicates the overall 
status of your local adjustment. 

Item Status - indicates the status of the 
respective instructional material.  Possible 
statuses are Pending and Posted. 
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Local Adjustments: Step-by-Step 

Create a New Local Adjustment 

1. Click on (Inventory) on the Navigation Bar. 

2. Under the Adjustments subcategory, click on Adjustments. 

3. Click on the (Local Adjustments tab). 

4. Click on (Add). 

5. Select an adjustment type from the Adjustment Type drop-
down menu. 

6. Name the Local Adjustment. 

7. Click on (Next). 

8. If a description is desired, enter it in the Description fi eld at 
the top of the page. 

9. Use Search to find the item you want to adjust. 

10. Click on the title. The row highlights to orange. 

11. Enter a number of Copies to Adjust. 

12. Click on (Add). 

13. Repeat steps 9 through 12 until all items to adjust have been 
added. 

14. When finished, click on (Save). (You can still edit the 
adjustment at this point. After you have posted your local 
adjustment, you can no longer edit it.) 
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Edit a Local Adjustment 

Local adjustments  in the status of New can be edited. If you do 
not see the (Edit) icon, you are no longer able to edit this local 
adjustment. 

1. From Inventory on the Navigation bar select 
Adjustments, and click on the Local Adjustments tab, 
use Search to find the local adjustment you want to edit. 

I2. Click on (Edit) to make changes to your local 
adjustment. 

3. Make the desired changes or add additional items to your 
local adjustment. 

4. When finished, click on  (Save). (You can still edit 
the local adjustment at this point. After you have posted 
your local adjustment, you can no longer edit it.) 

Post a Local Adjustment 

The term Post applies to the process that reduces the inventory of a title 
listed on a local adjustment. 

1. From Inventory on the Navigation bar select Adjustments, 
and click on the Local Adjustments tab, use Search to fi nd 
the local adjustment you want to post. 

2. Click on (Details) for the Local Adjustment containing 
the titles you want to post. 

3. Verify the item and quantity in each row and then click on 
(Post). 

4. To post all of the verified titles and quantities, click on 
(Post All). 

5. To set a title to Complete, click (Complete) in the row 
of the corresponding title. (This completes the adjustment
without receiving the items.) 

6. When you are finished, click on (Previous Page) to
return to the Local Adjustment page. 
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Practice Activity 

In pairs or in small groups read the following scenarios and answer the questions. 

1. What icon on the main navigation bar would you select to decrease your 
inventory numbers? 

2. Why would you create a Campus Vendor Order instead of a Campus
Requisition? 

3. You created a local adjustment to record destroyed titles.  The teacher 
reported that 8 books are no longer usable.  Your local adjustment refl ects 
this.  However, after reviewing the books yourself, 3 additional copies should be 
removed from use.  How do you correct the local adjustment (which is still in 
the status of “New”) to reflect the increase? 
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Reports 

Overview 

Reports displays the reports available for printing by category. 

Here you can produce reports (selective data lists) which provide the 
information you need to account for instructional materials. 

There are three main types of reports: 

• Reports - displays information in sequential order, one 
student/teacher/item following the previous.  
(For example, a Student Distribution Report will
display multiple students per page). 

• Receipts - displays information separated by student or
teacher.  (For example a Student Distribution 
Receipt  will display one set of student data per R
page or page break.). 

•  Form Letters - customizable form letters that allow you to 
communicate with parent/guardians, and/
or students, regarding the instructional 
materials for which they are accountable. 

You can refine all of your reports, receipts and letters by Filtering and 
Sorting the data in multiple ways. 

R
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Important! 

In TIPWeb-IM most reports are viewed and printed in PDF format
which requires the Adobe Acrobat Reader® software. 

If you do not have Adobe Acrobat Reader® on your computer, 
download it free of charge at: 

www.adobe.com 
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Reports: Introduction 

Main Reports Screen 

All Reports - shows you an entire list of all 
TIPWeb-IM default reports and receipts.  It 
excludes letters and My Report established 
reports. 

Bar Code Reports - includes the following 
reports which produce barcodes ready for 
scanning:  Class Rosters, Student Listings, and 
Teacher Listings. 

Campus Reports - includes the following reports: 
Campus Analysis of Need, Campus Requisition 
Report, and Campus Transaction Report. 

Form Letters - TIPWeb-IM comes with three 
default letters:  Two “collection” letters (one in
English and the other in Spanish), the third is a 
Student Contract Letter.  Use the Form Letter 
Editor to create/customize each letter’s contents. 

Inventory Reports - includes the following 
reports:  Campus Digital Material Report, Campus
Distribution by Title Report, Campus Inventory 
Worksheet, and Vendor Order Report. 

My Reports - allows you to filter reports while 
saving all of the characteristics of that report for 
repeated use. This way, you do not have to go
through the steps of filtering every time you want
the same report with updated data. 

Other Reports - includes the following reports:  
Campus Courses Listing Report and Subject Area
Listing Report. 

Student Reports - includes the following 
reports:  Charge Receipt, Class Roster Book
Check, Distributions to Students not Enrolled in 
Course Report,  Student Charge Summary Report, 
Student Textbook Receipt, Student Textbook 
Status Report, Student Transaction Receipt, and 
Students with No Distributions. 

Teacher Reports - includes the following reports: 
Class Roster Book Check, Teacher Classroom 
Set Worksheet, Teacher Textbook Receipt, and 
Teacher Textbook Status Report. 

Textbook Reports - includes the Campus
Textbook Details Report, Components Listing 
Report, and Textbook Basic Report. 
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Select Report Screen 

Filter  - allows you to 
customize information displayed 
on the report by choosing which 
information you want to view.  This 
excludes all other available data. 

CSV  - launches the CSV 
“whole” version of the respective
report using all available data -
excluding nothing.  CSV fi le formats 
can be open within most text editor
programs, however, they are most
commonly opened in spreadsheet 
programs (such as MS Excel).  This 
allows users to edit, sort, fi lter, and 
save data as desired. 

Report  - launches the PDF 
“whole” version of the respective

Description For box displays 
the Purpose, Filters, Sorts, and 
Description available for each 
report.  You must click on a Report 
Name for this to populate with the 
respective information.  Otherwise, 
you will be reading the information 
pertaining to the default report. 

For instance:  On the All 
Reports screen, the default 
Description For provides
information on the Campus
Analysis of Need Report. 

Grayed out icons display functions 
which not available to the user 
as some reports do not of er the 
ability to filter, produce a CSV 
report, and/or a PDF report. 

report using all available data -
excluding nothing. 
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Filter a Report Screen 

Set tabs  - there are four tabs for 
which two filter criteria can be set. Within each 
of the criteria you decide if you want an AND 
statement or an OR statement. 

AND radial button  - links separate search 
criteria together.  AND specifies that all terms 
must be present in the record.  AND narrows a 
search since the more terms you join with AND 
the fewer results you will receive. 

OR radial button  - separates  search 
criteria.  OR specifies that either term may 
appear in the record. 

Set box  - located on the right hand side
of the page links the Set Tabs together with its 
own And/Or criteria. 

Sorting tab  - allows sort options 
which are available for most reports. You can also 
select an ascending or descending order. 

Summary tab  - summarizes 
all of the filters, their criteria, and the sorts 
applied to the respective report for you to review. 

Print icon  displays a PDF version of the 
report using all available data combined with
your filters and sorts. 

Save icon  allows you to save all fi lters and 
sorts for the respective report and store these 
settings in the My Reports area. 
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Filter a Report 

Filtering reports allows you to refine information displayed on the 
report. Each report in TIPWeb-IM ofers a diferent set of fi lters and 
sorts. 

1. Click on (Reports) on the Navigation Bar. 

2. Under the Select Report Category, use the drop down menu 
to select the respective report category or the All Reports
menu option to view all available reports. My Reports and 
Form Reports are not included in the All list. 

3. Click on (Filter) located in the same row as the report 
you want to view and/or print. 

2

3

Reports: Step-by-Step 

Continued on next page 
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4. Begin setting the filters under the Set 1 tab  by using 
the drop down menus and entering the specifi c information 
you want to use in your fi lter. 

4a. Be sure to determine the And/Or criteria if you are 
setting more than one fi lter. 

4b.   If you need to set more than two filters, you must 
choose the AND/OR criteria which links the Set 1 Tab 
to the Set 2 Tab filters.  To do this, look for the Set 
box on the far right hand side of the screen. 

5.   Select  (Print) to open the PDF version of the report. 

4

5

4a 4b

Did you 
know? 

There are eight total fi lters 
- four sets (Tabs 1, 2, 3, 4) 
of filters with two criteria 
per set. 

Within each of the criteria 
you decide if you want an 
AND statement or an OR 
statement. 

AND Example: 

You want a report of all 
students who have two 
specific titles assigned to 
them. 

For example: Sally Learns 
to Whistle  AND  Billy 
Learns to Skate. 

OR Example: 

You want a report of all 
students who either have 
one title or another title. 

For example: Algebra I  OR 
Advanced Algebra 
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Sort a Report 

Sort options are available for most reports. However, the sort options 
difer for each report. 

1. Select the Sorting tab  , located on the 
Reports’ Filters page. 

2. From the drop-down menu, select one of the sort options. 
You can also select an ascending or descending order. 

3. Select  (Print) to open the PDF version of the report. 

R 
Create a My Reports Report 

My Reports allows you to filter reports while saving all of the 
characteristics of that report. This way, you do not have to go through 
the steps of filtering every time you want the same filtered report with 
current results. 

1. From the Report Filter screen, enter the desired fi lter 
settings and/or sort options. 

2. Save the filter and/or sort settings by clicking on the 
(Save My Report Criteria). 

3. Name your My Reports settings with a descriptive name 
which is meaningful to you in the Report Name fi eld. 

4. Click on  (Save My Report). 

5. Your saved report can be found in the reports menu under 
My Reports. 
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Print a PDF Report 

1. Click on (Reports) on the Navigation Bar. 

2. Under the Select Report Category, use the drop down menu 
to select the respective report category or the All Reports
menu option to view all available reports. 

3. Click on (Reports) located in the same row as the report 
you want to view and/or print. 

4. The File Download dialog box opens, asking you if you want 
to Open, Save, or Cancel. 

Click Open. 

5. The report opens in the Adobe Acrobat Reader®. Review 
the report by navigating through it using the Adobe Acrobat 
Reader® tools. 

6. Go to File > Print, located on the tool bar or click on 
(Print). 

7. The Adobe Acrobat Reader® Print dialog box opens. Select 
the printer to which you want to print, the range of pages, and 
the number of copies to print. 

Click (Print). 

Did you 
know? 

By selecting the Summary 
tab, you can view all of your 
filters and sorts. 

When you get interrupted 
and forget which fi lters and/ 
or sorts you applied to the 
respective report, this area 
lists out what has been 
selected. 

See a sample summary of 
filters and sorts below: 

Hayes Software Systems 52 Ask Our Customer Support Team!  800-495-5993 



    

    

   

  

 

Practice Activity 

In pairs or in small groups read the following scenarios and answer the questions. 

1. You issued an Art teacher enough books for a class set.  She would like 
to be able to lend some of those books to students for weekend projects.  
What do you print out for the teacher to help keep track of those 
textbooks? 

2. The students on campus do not have IDs for the distribution process. 
What reports are available to help you with this issue?  How do you print 
them by grade level and then alphabetically by last name? 

R 

3. How many campus requisitions are currently in the status of New or 
Submitted?  Is there a report which can show you all requisitions in the 
status of New or Submitted? 

4. It is time to do a book check to make sure students and teachers have the 
books which were issued to them at the beginning of the year.  Which 
reports would be most beneficial to accomplish this task? 
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Automation 

Overview 

The Automation icon is where you will manage information 
pertaining to bar coding of instructional materials. Here you can: 

• Manage PDA fi les - For those of you using a hand-held/ 
portable scanner to distribute and collect instructional 
materials, this area will allow you to view any errors 
resulting in the transferring of the PDA files to the TIPWeb-
IM data. 

• Quick Entry - For those using attached scanners (a wire
connects the scanner to your computer), this area allows
you to perform distributions/collections. 

• Print ISBN/accession bar code labels - For all users, this 
is the area where you print the labels which are placed on
the instructional materials allowing the distribution and 
collection process to take place. 
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Automation: 
Print ISBN & Accession Bar Codes 

Overview 

TIPWeb-IM prints the ISBN and the accession number on the same 
bar code label.  Here is an example: 

ACCESSION 

ISBN
0254512544 

Property Of 

Statistics of Accounting 

75698 

Learning ISD 

N 

TIPWeb-IM makes it easy to print bar code labels to your printer. 
There are no special instructions for preparing your printer for bar code 
printing. If your printer works with other Web applications, then your 
printer should be able to print bar codes from within TIPWeb-IM. 

We recommend that you use a laser printer with a setting of 600 
dpi (dots per inch). 

Use the Avery 6578 size label for printing. This sheet contains three 
labels across and five down.  Here is an example: 

ACCESSION 

ISBN 
0254512544 

Property Of 

Statistics of Accounting 

75698 

Learning ISD 

ACCESSION 

ISBN 
0254512544 

Property Of 

Statistics of Accounting 

75699 

Learning ISD 

ACCESSION 

ISBN 
0254512544 

Property Of 

Statistics of Accounting 

75700 

Learning ISD 

ACCESSION 

ISBN 
0254512544 

Property Of 

Statistics of Accounting 

75701 

Learning ISD 

ACCESSION 

ISBN 
0254512544 

Property Of 

Statistics of Accounting 

75702 

Learning ISD 

ACCESSION 

ISBN 
0254512544 

Property Of 

Statistics of Accounting 

75703 

Learning ISD 

ACCESSION 

ISBN 
0254512544 

Property Of 

Statistics of Accounting 

75704 

Learning ISD 

ACCESSION 

ISBN 
0254512544 

Property Of 

Statistics of Accounting 

75705 

Learning ISD 

ACCESSION 

ISBN 
0254512544 

Property Of 

Statistics of Accounting 

75706 

Learning ISD 

ACCESSION 

ISBN 
0254512544 

Property Of 

Statistics of Accounting 

75707 

Learning ISD 

ACCESSION 

ISBN 
0254512544 

Property Of 

Statistics of Accounting 

75708 

Learning ISD 

ACCESSION 

ISBN 
0254512544 

Property Of 

Statistics of Accounting 

75709 

Learning ISD 

ACCESSION 

ISBN 
0254512544 

Property Of 

Statistics of Accounting 

75710 

Learning ISD 

ACCESSION 

ISBN 
0254512544 

Property Of 

Statistics of Accounting 

75711 

Learning ISD 

ACCESSION 

ISBN 
0254512544 

Property Of 

Statistics of Accounting 

75712 

Learning ISD 

S
c

a
n

n
in

g
 

support.hayessoft.com 55 TIPWeb-IM Campus Training Manual 

https://support.hayessoft.com


 

 

  
 

 
 
 

 

 
 

  

 
 

  

 

 
 

  

 
  

Did you 
know? 

TIPWeb-IM has been 
formatted to print labels that 
are 2 x 2 5/8 with 15 labels per 
sheet.  Avery labels 6572 and 
6578 are examples that work 
well. 

Print Bar Codes: Introduction 

Print Bar Codes Screen 

Select Starting Label icon  allows you to 
select the label on which the printer will start 
the print job. 

Grid Header is clickable and will sort 
your instructional materials (ascending or
descending) by the menu item you select.  
Available menu bar items to sort by are:
ISBN, Title, SLC, and Vendor/Publisher. 

Labels to Print field allows you to determine 
how many labels will be printed.  This fi eld will 
default to the Books Owned quantity. 

Avery 6572 or 6578 are 
polyester type labels.  This 
label is durable and will 
withstand the abuse of 
everyday handling.  It is 
almost impossible to rip or 
tear. 

A plain paper label can be 
used, however, they tend to 
wear over time without a 
protective covering.  Consider 
using some type of protective 
cover when placing them on 
the instructional materials. 
Clear standard packing tape 
works well and is very cost 
efective.  Librarians use a 
special clear label which 
is nearly indestructible.  
However, these library 
protectant strips can be 
expensive. 
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Select Starting Label Screen 

Print icon  launches the PDF document 
which contains the ISBN and Accession Bar 
Codes. 

Cancel icon  returns you to the Print Bar 
Codes page. 

Starting Label drop down menu allows you to 
determine which label your print job starts on.  
NOTE: The numbers listed on the sample sheet 
of labels is the direction the printer will print 
your labels (down then across). 
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Print Bar Codes: Step by Step 

Print an ISBN & 
Accession Bar Code 

1. Click on (Automation) on the Navigation Bar. 

2. Click on (Print ISBN & Accession Bar Codes). 

3. Use Search to find the title of the item. 

4. Click on the title for which you need bar code labels. 

5. Insert the quantity of labels you want to print in the 
Labels to Print fi eld. 

6. To begin printing, click on  (Print). 

OR 

Click on the (Select Starting Label) to select the 
starting label. 

Important! 

Within the Adobe Acrobat Reader® print screen, make 
sure: 

 Page Scaling is set to None 

 Auto-Rotate and Center check box is selected (which is 
the default setting) 

Did you know? 

Bar codes are read by sweeping 
a small spot of light across the 
printed bar code symbol. The 
sweep starts at the white space 
before the first bar and ends in 
the white space which follows the 
last bar. 

Bar codes are like a printed 
version of the Morse code. 
Diferent bar and space patterns 
are used to represent dif erent 
characters.  Sets of these 
patterns are grouped together 
to form a “symbology”. There 
are many types of bar code 
symbologies, each having their 
own special characteristics and 
features. 

Most symbologies were designed 
to meet the needs of a specifi c 
application or industry. For 
example the UPC symbology was 
designed for identifying retail 
and grocery items and PostNET 
was designed to encode Zip 
Codes for the US Postal Service. 

TIPWeb-IM uses bar code 
symbology code 128A. This 
is a high-density bar code 
symbology which is self-checking 
and is used for alphanumeric or 
numeric-only barcodes.  Code 
128A includes the following 
44 characters: 123 4567 89 0 
ABCDEFGHIJKL 
MNOPQR S TUV W X Y Z - .  
*$/+% . 
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Automation: Quick Data Entry 

Overview 

Quick Data Entry allows you to use your attached/connected
scanner to distribute and collect instructional materials directly into 
TIPWeb-IM through a scanning process. The following is an example 
of an attached/connected scanner: 

 LS 2208 

You can see the information you are scanning and can print a receipt 
as soon as you have distributed or collected all of a student’s or 
teacher’s instructional materials. 

These are the types of data entry within Quick Entry: 
• Collect by Accession - collect items from students and 

teachers 
• Student Distribution - assign items to students with 

accession numbers 
• Teacher Distribution - assign items to teachers with 

accession numbers 
• Teacher Distribution without Accessions - assign items to 

teachers without accessions 
• Teacher Collection without Accessions - collect items from S 

teachers without accessions 

Some of these types of data entry within Quick Entry allow you to 
Remember Data Field(s). If given the choice, you can: 

• Remember ID 

• Remember ISBN 

• Remember ID and ISBN 

• Do Not Remember Values (default setting) 

Even if you chose one of these options, TIPWeb-IM allows you to 
switch the remembered information during the scanning process. 
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BRANDON C ABDELRAHIM 

KATHERINE D ABERLY 

MARISSA J ACHEE 

ASHLEY N ACKER 

DANIELLE M ACOSTA 

Did you 
know? 

Quick Data Entry works 
best when using bar codes 
and an attached scanner. 
This allows data to be read 
quickly and accurately. 

If your school does not 
provide ID cards with a 
student’s and/or teacher’s 
ID number in the form of a 
bar code, TIPWeb-IM has 
reports which can be printed 
and used instead. 

For student ID bar codes, 
print the Student Listing 
With Bar Codes Report. 
For teacher ID bar codes, 
print the Teacher Listing 
With Bar Codes Report. 

Learning High School 

Student Listing with Bar Codes 

Wednesday, December 09, 2009 

GINA ABBOTT 
887766 

KRISTIN M ABBOTT 
860883 

LAUREN R ABBOTT 

CHRISTOPHER R

ABEYWICKRAMA 

CRYSTAL ABOSO 

JASON I ABREU 

DAVID N ACOSTA 
861377 

KENDRA S ACOSTA 
857113-T1 

Mason ACOSTA 
862597 

Student ID 

Student Name 

Student ID 

Student Name 

846803 

AHIM 

Y 

EE 

KER 

ACOS 
1 

Wednesday, December 09, 2009 

Teacher Listing with Ba 
Learning High School 

NILAY ADCOCK 

LAURIE ANDERSON 

1004326 

ASHLEY E ARCHIBALD 

1032 

DONNA ARMSTRONG 

1036 

RAFAEL V ASHLEY 

1046 

PAULA W BAEZA 

1057 

STEFANIE B BARNETT 

1060 

TOMMY R BATEMAN 

1061 

WILLIAM BEALL 

1068 

ANTONY L BELLOTTE 

1069 

TAMI L BENNETT 

1067 

LORI J BERNSTEIN 

1071 

SHIRLEY M BERTISON 

1072 

REBECCA A BERUBE 

1073 

WHITNEY G BIGHAM 

1077 

JIMMY M BLANKENSHIP 

1082 

DONALD G BOEHM 

1092 

LOU A BOND 

1093 

HERBERT C BOWMAN 

1094 

CLINTON R BOYER 

1100 

SANDRA J BRADLEY 

1102 

SANDRA S BRASHIER 

1112 

Teacher Name Teacher ID Teacher eTeacher ID 

Quick Data Entry: Introduction 

Quick Data Entry Screen 

Data Type drop down menu allows you to choose whether you 
will be distributing items to students or teachers (with or without 
accessions) or collecting items. 

Remember Data Field(s) radial buttons allow you to choose 
to remember certain fields.  Not all data types allow you to 
remember data fields.  The buttons will be greyed out if you are 
not able to choose them. 

Start Scanning icon  will launch the Quick Entry 
Scanning screen.  This is the screen where you enter the 
distribution or collection data - whether by scanning or by hand 
entering. 

Refresh (Clear Page) icon  refreshes the search area and 
returns the screen to it’s original state. 

Did you know? 

The following are possible error messages you might encounter: 
• Not enough copies in storage 
• Student/Teacher not in database 
• ISBN not distributed to Student/Teacher 
• Accession has a status of (code) and is assigned to 

(student/teacher name) at campus 
• Student/Teacher/ISBN/Accession # is longer than the 

maximum fi eld length 
•  The accession not in use 
•  Accession must be numeric 
•  Invalid ISBN 
•  Not enough copies distributed to teacher 

 

  
 

 

 

 

  

 
 

 

 

 

   
   
   
   

   

846803

861140

860990

820719

853595

MICHELLE L ACOSTA
857324

ROBERT B ADAMCIK
861713

JARED W ADAMS
850402

NICHOLAS S ADCOCK
825084

1 124
Page of

861140

860990

820719

TA
853595

MICHELLE L ACOSTA
857324

ROBERT B ADAMCIK
861713

JARED W ADAMS
850402

NICHOLAS S ADCOCK
825084

124
Page of

r Codes

1015

Nam
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Data Entry Scanning Screen 

Save icon  uses the information entered into the 
corresponding field and verifies it against your TIPWeb-IM 
data.  If there is an issue, a warning message will appear in red 
text.  If you are entering the data manually (not scanning), you 
either click on this icon or use the Enter Key on the keyboard 
to activate this process. 

Today’s Receipt icon  launches the individual’s receipt 
which displays all of today’s activity on the respective account. 

Full Receipt icon  launches a receipt which shows all of
the transaction history for the entire school year - regardless
of item statuses. 

Book History lists all distribution history for the ID most
recently scanned and displayed in the ID fi eld. 

Change Status icon opens the Change Staus screen to 
change the status of an item distributed to the student. 

Assess Charge icon allows a charge to be assessed for any 
item listed in book history for the ID most recently scanned 
and displayed in the ID fi eld. 
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Quick Data Entry: Step by Step 

Using Quick Data Entry 

1. Click on (Automation) on the Navigation Bar. 

2. Click on (Quick Data Entry). 

3. Select the data entry type from the Choose Type of Data 
Entry drop-down menu. 

4. Select one of the Remember Data Field(s) radial buttons, if 
applicable. 

5. Click on  (Start Scanning). 

6. Enter the corresponding data into the required fi eld (manually 
or scanning) 

7. To print a receipt, click on (Today’s Receipt) or
(Full Receipt) after each student or teacher. 

Assessing a Charge in Quick Entry 

1. Follow steps 1 through 6 above.  

2. Locate the instructional material for which you want to Assess 
a Charge or Change the Status in Book History located in the 
bottom right portion of the screen. 

3. Click on (Assess Charge) or  (Change Status) in the 
corresponding row. 

4. From this point, the steps to complete each process are identical to 
the steps found under Students/Teachers on the Navigation bar. 

5. Click on (Save) to return to the Quick Entry page.. 

How Many 
Scanners 
Do I Need? 

We suggest a minimum 
of one scanning unit per 
800 students and ideally 
one scanning unit per 
600 students. 

The device you select is 
dependent on internet 
connectivity within the 
building, the layout 
of the building, the 
number of book rooms, 
and the location of the 
book rooms within your 
building. 
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Practice Activity 

In pairs or in small groups read the following scenarios and answer the 
questions. 

1. You just printed 30 sheets of ISBN and Accession number bar 
codes, then you spilled cofee all over them!!!  What do you do 
now? 

2. An error message saying “Invalid ISBN” comes up while you are 
scanning out books to a student.  What do you do? 

3. Using Quick Data Entry, what data type do you use if you want to 
distribute consumable workbooks to teachers? 

S 
4. Tommy turns in his book and you notice that he has torn page 65.  

How do you charge him for this damage? 
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 Textbooks 

Overview 

Textbooks is where textbooks or other materials can be viewed 
and/or added to the TIPWeb-IM database. 

Selecting this icon will produce a list of instructional materials 
which can be limited by search criteria you select. 

Click on a specific title to display: 
• The total number of items in inventory 
• The number of items issued 
• The number of items currently in storage 

Textbooks can also be distributed from this icon. 

TIPWeb-IM’s Alphabet Soup 

Within TIPWeb-IM, you will find many acronyms and abbreviations.  They are: 

ISBN - International Standard Book Number:  This is the 10 or 13 digit number 
assigned by the publisher of each book title. 

SLC - State List Code:  Some states assign numbers to groups of instructional 
materials.  Texas uses a four digit number which represents the grade 
level and subject area which they refer to as the multi-list code. 

CLTD - Collected: A returned item. 

DIST - Distributed: An item in use by a student or teacher. 

DSTY - Destroyed:  An item identified as hazardous, flood damaged, or stolen. 
No payment is expected and the item is unusable. 

LOST - A temporary status, waiting for payment or for the item to be found. 

PAID - Payment has been received for the FULL amount of an item. 

PRTL - Partial Payment: This indicates a partial payment for an item. It is a 
temporary status which should result in full payment. 

XFER - transfer - only seen on teacher distributions and designates an item 
was transfered from the respective teacher to another individual. 
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Main Textbooks Screen 

Distribute icon  performs instructional material
distribution to a student or a teacher. 

Paging feature  at the bottom 
of the list, as shown in the screen capture above.  It 
improves response time and allows you to easily navigate 
through the list. 

Click on the item’s ISBN or title to see the instructional 
material’s total number of items in inventory, number 
of items issued, and the number of items currently in
storage on the lower half of this screen. 

Grid Header is clickable and will sort your campus’ 
instructional materials (ascending or descending) by the 
menu item you select.  Available menu bar items to sort 
by are:  ISBN, title, SLC, vendor name, material type, and 
subject area. 

Textbooks: Introduction 
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Textbooks Distribution Screen 

SOURCE TARGET 

Select a Source Select a Target 
drop down allows you to choose from drop down allows you to choose to where 
where/whom the item will be selected for the item is being distributed. 
distribution. 

TRANSFER 

Accession Number field is where you 
enter the item’s assigned accession 
number. 

Transfer icon  transfers the source’s 
selected instructional material to the 
selected target. 
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Textbooks: Step-by-Step 

Distribute a 
Textbook from Textbook 

1. Click on (Textbooks) on the Navigation Bar. 

2. Use Search to find the item you want to distribute. 

3. Click on (Distribute) in the row listing the item you want to 
distribute. The Distributions page opens. 

32

1

Continued on next page 
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4. In the Target area (located in the lower grid of the page), select 
the target (to whom the item will be distributed) using the drop-
down menu. 

5. Use the scroll bar to locate the target person or use the Search By 
drop-down menu and the Search field to narrow your search. 

6. Click on the person to whom this item will be distributed. The 
row highlights to orange.  (On the right side of the page, the 
person’s current distribution history displays.  If they do not
have an item checked out to them, a message stating No Books 
Assigned to..., displays.) 

7. In the Accession Number field (located in the center of the page), 
enter the accession number of the item being distributed. 

Note: Student distribution is reflected in the screen shot below. 
Distribution to a teacher requires the number of copies to be
entered before entering accession numbers. 

8. Click on (Transfer). 

9. Transaction Completed! will appear next to the Transfer icon 
and the item is now in the person’s current Books Assigned To... 
list. 

8
4

5

6

7

Did you 
know? 

Distribution can be 
automated with the 
addition of a connected 
bar code scanner. 

The bar code scanner 
allows you to scan 
directly into the 
displayed window. 

Place your cursor into 
the field you wish to 
scan data into, and then 
scan away! 

It is that simple! 
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Practice Activity 

In pairs or in small groups read the following scenarios and answer the 
questions. 

1. You need a quick inventory breakdown for a specific textbook.  Where 
do you go? 

2. Great! You have enough of the above mentioned textbook to distribute
to the student standing in front of you.  How do you quickly issue them 
this book? 

3. On the distribution screen, if the Source is selected as Storage, what 
are your only two options for a Target? Why? 
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 Students 

Overview 

Students is where you view and manage information 
pertaining to your students. 

All student instructional material transactions and their 
history, class schedule, distributions, collections, ability 
to change material status, and charges can be assessed/
performed from the student screen. 

There are two types of students:

 • Active - students who are currently enrolled in your 
school/campus

 • Inactive - students who are no longer enrolled in 
your school/campus. 

Did you 
know? 

For the majority of our 
TIPWeb-IM customers, 
student data is updated 
automatically from 
your school’s student 
information system. 

This signifi cantly 
reduces the amount 
of data you would 
otherwise be required 
to manually add to this 
database. 

You can certainly add 
new students manually 
when necessary—you 
just do not have to do 
that very often. 
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Main Students Screen 

Details icon  displays the student detail screen.  This page displays 
the student’s contact information, ID number, grade level, homeroom, 
schedule, book history, and notes. 

Distribute icon  performs instructional material distribution to a 
student. 

Click on the student’s name to see the student’s items currently 
assigned to him/her and their status. 

Change Status icon  opens the Change Status screen allowing
you to change the status of an item distributed to this individual. 

Collect to Storage icon  collects the item from this individual and 
changes the status to CLTD (collected). 

Collect to Teacher icon  collects the item from this individual, 
transfers the item back to the respective teacher’s account (with a 
status of DIST), and changes the status to CLTD (collected) on the 
student’s account. 

Assess a Charge icon  opens the Assess a Charge screen allowing
you to assess a charge for damage to the item. 

Show Inactive  check box displays 
those students not currently enrolled in your school/campus. 

Students: Introduction 
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Students Detail Screen 

Quick Reports drop down menu allows you to select a quick 
report pertaining only to this student. 

History tab  displays the student’s instructional 
material distribution history. 

Schedule tab  displays the student’s schedule as it was 
last updated from your student information system. 

Assessed Charges tab  displays status of charges 
assessed to the student.  Payments can be made by clicking on 
the Payment icon. 

Did you 
know? 

TIPWeb-IM uses the 
student’s ID to create 
a student account. 
TIPWeb-IM brings in 
student information 
from your school’s 
student information 
system (SIS) and, if 
that system creates 
a new ID number, 
TIPWeb-IM will also 
create a new TIPWeb-
IM student account. 

This means you need 
to be aware of the 
ID number you enter 
when manually adding 
a new student.  If the 
number you enter is 
incorrect, the next 
time the SIS updates 
TIPWeb-IM, it will use 
the correct number.  
Now you have two 
accounts for one 
student. 

Likewise, if you try 
to enter a student 
ID number which 
is already in use, 
TIPWeb-IM will give 
you an error message 
and request you use 
another ID number. 
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Add a Student Record 

1. Click on (Students) located on the Navigation Bar. 

2. Click on (Add). 

3. Enter the student’s information in the provided fi elds. 
Note: Required information is displayed in red. 

4. To save your entry, click on (Save). The following pop-up 
window displays: 

5. Click OK. A message stating You have successfully added a 
student displays. 

Edit a Student Record: 

1. Click on (Students) located on the Navigation Bar. 

2. Use Search to find the student whose information you want to 
edit. 

3. Click on (Details) in the row listing the student whose 
information you want to edit. 

4. Click on (Edit) to change the information. 

5. Edit the required information, click on (Update). The 
following pop-up window displays: 

6. Click OK to continue. 

7. The message You have successfully updated the student
appears at the bottom of the page. D8. Click on (Previous Page) to return to the Student Details 
page. 
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Inactivate a Student Record 

This inactivates the status of the student.  By inactivating the 
student’s status, you can retain their past distribution records without 
having them show up in the grid for active or enrolled students. 

1. Click on (Students) located on the Navigation Bar. 

2. Use Search to find the student record you want to inactivate. 

3. Click on (Details) in the row respective to the desired 
student. 

4. Click on (Inactivate). 

5. Click on OK to complete. 

Did you 
know? 

When you delete a student, 
the student and their book 
history are stored in an 
inactive status.  

Book history for inactive 
students is displayed on 
student reports but is not 
part of the Student Listing 
with Bar Codes report.  

To display inactive 
students, click in the box 
next to “Display only 
inactive students” found in 
the upper right side of the 
Students screen. 
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Distribute a 
Textbook From Students 

1. Click on (Students) on the Navigation Bar. 

2. Use Search to find the student to whom you want to  
distribute an item. 

3. Click on (Distribute) in the row listing the student to 
whom you want to distribute to. The Distributions page 
opens. 

3

2

1

Continued on next page 
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4. In the Source area (located at the top of the page), use the Search By 
drop-down menu and the Search field to narrow your search for the 
title to be distributed. (Note: The default setting for the Source drop
down menu will be Storage.) 

5. Click on the title to be distributed. The row highlights to orange. (On 
the right side of the page, the title and the number of available copies 
to distribute displays.) 

6. In the Target area (located in the lower grid of the page), verify the 
desired student’s information is selected. 

Note: The default setting for the Target drop down menu will be 
Student and the student will already be selected. On the right side of
the page, the person’s current distribution history displays.  If they do
not have an item checked out to them, a message stating No Books 
Assigned to..., displays. 

7. In the Accession Number field (located in the center of the page), 
enter/scan the accession number of the item being distributed. 

8. Click on (Transfer). 

Note: If you scanned the accession number with a scanning device, 
you do not have to click on the Transfer icon. 

9. Transaction Completed! will appear next to the Transfer icon and 
the item is now in the person’s current Books Assigned To... list. 

7
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Collect a Student Textbook To Storage 

1. Click on (Students) on the Navigation Bar. 

2. Use Search to find the student who is returning the items. 

3. Click on the student ID or name. The row highlights to 
orange. 

4. At the bottom of the page, a grid with all the instructional
materials assigned to this person displays. Locate the row 
that lists the item which needs a status change. 

5. Click on (Collect to Storage) in the row with the 
accession number in question. 

6. A pop-up message displays, asking you if you really want to 
return this item to storage. 

7. If you do, click OK. 

Collect a Student Textbook To Teacher 

If an item was transferred from a teacher’s account directly to a 
student’s account, the student’s account will allow you return the item 
to the teacher.  If there is no icon allowing you to do this, it means this 
particular accession number was not transferred to the student from 
the teacher’s account. 

1. Click on (Students) on the Navigation Bar. 

2. Use Search to find the student who is returning the items. 

3. Click on the student ID or name. The row highlights to orange. 

4. At the bottom of the page, a grid with all the instructional
materials assigned to this person displays. Locate the row that lists 
the item which needs a status change. 

5. Click on (Collect to Teacher) in the row with the accession 
number in question. D 
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Change Status 
of a Student’s Textbook 

1. Click on (Students) on the Navigation Bar. 

2. Use Search to look for the person who has material which 
needs a status change. 

3. Click on the ID or name of the student who needs to have 
material status changed. The row highlights to orange. 

4. At the bottom of the page, a grid with all the instructional
materials assigned to this person displays. Locate the row 
that lists the material which needs a status change. 

5. Click on (Change Status) in the corresponding row. 

6. In the center of the Change Status page, select the New 
Status drop-down menu. 

7. Choose from one of the following status options: 

• Lost (LOST) 

• Destroyed (DSTY) 

• Partial (PRTL) 

• Paid (PAID) 

• Return to Storage (CLTD) 

8. Click on (Change Status). 

Did you 
know? 

To change the status 
to Partial, you are 
required to enter a 
dollar amount into the 
Payment field at the 
bottom of the page. 

It is a best practice to 
enter the amount paid, 
the date, and form of 
payment in the notes 
field before clicking on

 (Change Status). 

This allows you to 
easily see how much 
the student paid and 
when. 
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Assess a Charge to a Student 

To assess a charge for a fee or fine to an instructional material on a 
student record, use the following steps: 

1. Click on (Students) located on the navigation bar. 

2. Use Search to find the student to whom you want to assess the 
charge. 

3. Click on the name of the student who needs the charge
assessed. The row highlights to orange. 

4. At the bottom of the page, a grid with all the instructional 
materials assigned to this student is displayed. Locate the 
row that lists the instructional material that needs a charge 
assessed. 

5. Click on  (Assess Charge) in the corresponding row. 

6. Click on the Type drop down menu and select a Charge Type. 

7. Enter any notes you wish in the Notes fi eld. 

8. Click on  (Save). 

9. Click on  (Print) to print a Charge History Receipt. 

10. Click on  (Exit) to close the Assess a Charge screen. 

Did you know? 

Charge Types are created by the district.  Depending on the 
settings established you may or may not change the price of a 
charge type* or view percentages based on the material’s unit price. 

*If the displayed Charge Amount is in black text, the charge amount can 
be changed. 

D
is

tr
ib

u
ti

o
n

 

D 
support.hayessoft.com 79 TIPWeb-IM Campus Training Manual 

https://support.hayessoft.com


     

    

     

    

    

  

  
 

 

    
 

   

   

    
 

    
  

  
 
 

  
  

 
 

 
 

 

 
 

 

Process a Charge 

Use the following steps to process a payment for a student’s currently
assessed charge: 

1. Click on (Students) located on the Navigation bar. 

2. Use Search to find the student for whom you want to process the 
charge payment. 

3. Click on  (Details) in the row listing the student whose charge 
you wish to process. 

4. Click on  (Assessed Charges Tab). 

5. Click on  (Payment) in the row listing the instructional 
material for which you want to make a payment. 

6. Enter the payment amount into the New Payment fi eld. 

7. Add any notes about this payment in the New Payment Notes 
fi eld. 

8. Click on  (Exit) to close the Assess a Charge screen. 

Print a Charge Receipt 
To print a Charge Receipt for currently assessed instructional materials, use 
the following steps: 

1. From (Students) on the navigation bar, click on (Details) 
in the row listing the person whose charge you wish to print. 

2. Click on the Quick Reports drop down menu and choose Charge 
Receipt. 

3. Click on  (Print). 

4. The File Download dialog box opens, asking you if you want to 
Open, Save, or Cancel. Click Open. 

5. Once open in Adobe Acrobat Reader, go to File > Print, located 
on the tool bar or click on (Print). 

Did you 
know? 

The Quick Data Entry 
and Find a Book 
screens allow you to
assess a charge to an
instructional material. 

Partial payments
for charges can be 
processed.  Enter the 
amount received. 
TIPWeb-IM will 
automatically satisfy
the charge when the full 
amount is reached. 

You can satisfy the 
charge at anytime by 
clicking on the Satisfi ed 
box - regardless of the 
amount received. 

If you wish to nullify the 
charge originally assessed 
to an instructional 
material, receive $0 in 
the New Payment
field and click on the 
Satisfi ed box. 
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Practice Activity 

In pairs or in small groups read the following scenarios and answer the 
questions. 

1. You need to verify a student is eligible for the textbook they are 
requesting.  How do you look up a student’s class schedule within 
TIPWeb-IM? 

2. ARGH!!!  You accidentally transposed some ID numbers in a new 
student’s account which was manually created yesterday.  Today, you 
have two accounts for this one student.  To make matters worse, you 
distributed all of their textbooks to the incorrect ID’s account.  How do 
you fi x this? 

3. A parent calls and wants a list of the items on their student’s account 
emailed to them.  Within the Students area, how do you accomplish 
this? 
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TEACHERS 

Overview 

The Teachers icon is where you will view and manage 
information pertaining to your teachers. 

All teachers/instructional material transactions and history 
as well as class schedule can be displayed. Distributions, 
collections, transfers and the change of status of items can 
be performed from this icon. 

There are two types of teachers:

 • Active - teachers currently working on your campus

 • Inactive - teachers who have left the campus 
this current school year.  This retains their past 
distribution records. 

Did You 
know? 

For the majority of our 
TIPWeb-IM customers 
teacher data is 
updated automatically 
from your school’s 
student information 
system. 

This signifi cantly 
reduces the amount 
of data you would 
otherwise be required 
to manually add to the 
database.  

You can certainly 
add a new teacher 
manually when 
necessary — you just 
won’t have to do that 
very often! 

Hayes Software Systems 82 Ask Our Customer Support Team!  800-495-5993 



  

 

 

 

  

D 

D
is

tr
ib

u
ti

o
n

 

Teachers Main Screen 

Click on the teacher’s ID or name to see the teacher’s 
assigned items on the lower half of this screen. 

Distribute icon  performs instructional material
distribution to the teacher. 

Collect icon  returns the teacher’s instructional 
material(s) to storage and gives the instructional 
material(s) the status of CLTD (collected). 

Change Status icon  changes the status of the 
teacher’s instructional material(s) to either LOST (lost), 
DSTY (destroyed), PAID (fully paid), PRTL (partial paid), 
or CLTD (return to storage). 

Transfer icon  moves the responsibility of the 
instructional material(s) from this teacher’s account to 
another person’s account (student or teacher). 

Teachers: Introduction 
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Teachers Details Screen 

Quick Reports drop down menu allows you to 
select a quick report pertaining only to this teacher. 

History tab  displays the teacher’s 
instructional material distribution history. 

Schedule tab  displays the teacher’s 
schedule as it was last updated from your student
information system. 

Assessed Charges tab  displays status 
of charges assessed to the teacher.  Payments can 
be assessed by clicking on the Payment icon. 

Did you 
know? 

A charge may be 
assessed to a teacher 
from two places: 

Assess a Charge from 
Find A Book 

Assess a Charge from 
Quick Data Entry 

A Receipt for the 
charge may be printed 
at the time the charge 
is assessed or a 
payment processed. 
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Teachers: Step By Step 

 
   

 

 

 

 

  

  

1. Click on (Teachers) located on the Navigation Bar. 

2. Click on (Add). 

3. Enter the teacher’s information in the provided fi elds. 
Note: Required information is displayed in red. 

4. To save your entry, click on (Save). The following pop-up 
window displays: 

5. Click OK. A message stating You have successfully added a teacher 
displays. 

Edit a Teacher Record: 

1. Click on (Teachers) located on the Navigation Bar. 

2. Use Search to find the teacher whose information you want to edit. 

3. Click on (Details) in the row listing the teacher whose 
information you want to edit. 

4. Click on (Edit) to change the information. 

5. Edit the required information, click on (Update). The following 
pop-up window displays: 

6. Click OK to continue. 
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7. The message You have successfully updated the teacher appears at
the bottom of the page. D 

8. Click on (Previous Page) to return to the Teacher Details page. 
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Inactivate a Teacher 

This inactivates the status of the teacher.  By inactivating the 
teacher’s status, you can retain their past distribution records 
without having them show up in the grid for active teachers. 

1. Click on (Teachers) located on the Navigation Bar. 

2. Use Search to find the teacher whose record you want to 
inactivate. 

3. Click on (Details) in the row listing the respective teacher. 

4. Click on (Inactivate). 

Process a Charge 

Use the following steps to process a payment for a teacher’s currently
assessed charge: 

1. Click on (Teachers) located on the navigation bar. 

2. Use Search to find the teacher for whom you want to process 
the charge payment. 

3. Click on (Details) in the row listing the teacher whose 
charge you wish to process. 

4. Click on (Assessed Charges Tab). 

5. Click on (Payment) in the row listing the instructional 
material for which you want to make a payment. 

6. Enter the amount of the payment into the New Payment fi eld. 

7. Add any notes about this payment you wish to enter in the 
New Payment Notes fi eld. 

8. Click on  (Exit) to close the Assess a Charge screen. 

Did you 
know? 

The  Quick Data 
Entry and Find a Book 
screens allow you to
assess a charge to an
instructional material. 

If you do not see the 
kind of Charge Type you 
would like to assess to 
this person, create a new 
Charge Type by typing it 
in the Type fi eld instead 
of selecting one of the 
existing Charge Types in 
the drop down menu. 

The last amount used to 
assess a charge for the 
Charge Type selected 
will appear. If you wish 
to change this amount, 
click in the Charge 
Amount field, delete the 
defaulted amount, and 
enter the desired Charge 
Amount. 
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Distribute a 
Textbook from Teachers 

1. Click on (Teachers) on the Navigation Bar. 

2. Use Search to find the teacher you want to distribute to. 

3. Click on (Distribute) in the row listing the teacher you 
want to distribute to. The Distributions page opens. 

3

2

1

4. In the Source area (located at the top of the page), use Search 
By drop-down menu and the Search field to narrow your 
search for the title to be distributed. 

5. Click on the title to be distributed. The row highlights to 
orange. (On the right side of the page, the title and the number
of available copies to distribute displays.) 

4

5



   

 

  

 

 

 
 

 

 
   

 

 
 

6. In the Target area (located in the lower grid of the page), verify the 
desired teacher’s information is selected 

Note: The default setting for the Target drop down menu will be 
Teacher and the teacher will already be selected. 

7. Verify the With Accessions? field is checked (if you do not wish to use 
accession numbers, unclick the box.) 

8. In the Copies field, enter the number of items you will be distributing to 
this teacher. 

9. Click on (Transfer). The Distributions With Accessions page opens. 

7

6

8 9

10. Enter all of the accession numbers assigned to the items you are 
distributing to this teacher. 

11. Click on (Transfer). 

12. All Distributions Completed! will appear next to the Previous Page 
icon. 

10

11

Did you 
know? 

Want to make entering 
accession numbers go 
faster?  

If you scanned the 
accession number with 
a scanning device, you 
do not have to click on 
the next field or 
(Transfer). 

However, if you are 
manually typing the 
accession number, you 
are required to click 
on  (Transfer) to 
register the accession 
number(s) entered into 
the Distributions 
With Accessions 
screen. 
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Change Status of a Teacher’s Textbook 

1. Click on (Teachers) on the Navigation Bar. 

2. Use Search to look for the teacher who has an item which needs 
a status change. 

3. Click on the ID or name of the teacher who needs to have an 
item status changed. The row highlights to orange. 

4. At the bottom of the page, a grid with all the instructional
materials assigned to this teacher displays. Locate the row that 
lists the item which needs a status change. 

5. Click on (Change Status) in the corresponding row. 

6. In the center of the Change Status page, select the New Status 
drop-down menu. 

7. Choose from one of the following status options: 
• Lost (LOST) 
• Destroyed (DSTY) 
• Partial (PRTL) 
• Paid (PAID) 
• Return to User (DIST) 
• Return to Storage (CLTD) 

8. Click on (Change Status). 

Collect a Teacher Textbook To Storage 

1. Click on (Teachers) on the Navigation Bar. 

2. Use Search to find the teacher who is returning items. 

3. Click on the teacher’s ID or name. The row highlights to  
orange. 

4. At the bottom of the page, a grid with all the instructional
materials assigned to this teacher displays. Locate the row 
that lists the item which needs a status change. 

5. Click on (Collect to Storage) in the row with the 
accession number in question. D6. A pop-up message displays, asking you if you really want to 
return this item to storage. 
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7. If you do, click OK 
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Transfer a Textbook to a Student 

If a teacher loans out an item which was distributed to themselves, 
it is possible to switch the responsibility of that item to the student 
or teacher who borrowed it.  In order transfer a distribution from a 
teacher to a student, you must have the accession number of the item 
prior to transferring the item. 

1. Click on (Teachers) on the Navigation Bar. 

2. Use Search to locate the teacher for whom the item was 
borrowed. 

3. Click on the teacher’s name. The row highlights to orange. 

4.   Click on (Transfer) in the row with the title in question. 

5. Click on the radial button next to the item’s title (located the 
top of the screen). 

6. In the Target area (located in the lower grid of the page), use 
the drop down menu to select Student as the target. 

7. Use Search By drop-down menu and the Search fi eld 
to narrow your search for the student the item should be 
distributed to. 

8. Click on their name. The row highlights to orange.  (On the
right side of the page, the person’s current distribution history 
displays.  If they do not have an item distributed to them, a 
message stating No Books Assigned to..., displays.) 

9. In the Accession Number field, enter the exact accession 
which was in the item loaned to the student/teacher. 

10. Click on (Transfer) 

11. The message Transaction Completed! will appear next to
the Transfer icon. 

Did you 
know? 

Don’t trust your eyes to 
visually verify a collection? 

You are not alone!  To 
digitally verify (by scanning) a 
collection, you can use: 

•  Find A Book 

•  Quick Data Entry 
(Collect by Accessions) 

These methods help guard 
against human error issues 
of visually verifying an 
item’s accession number or 
accidently clicking on the 
wrong collect icon. 

Try using them at dif erent 
collection times and see what 
works best for you and your 
campus. 
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Transfer a Textbook to a Teacher 

This process allows you to transfer some or all of a teacher’s distributions 
to another teacher by ISBN. 

1. Click on (Teachers) on the Navigation Bar. 

2. Use Search to locate the teacher for whom the item was 
borrowed. 

3. Click on the teacher’s name. The row highlights to orange. 

4.   Click on (Transfer) in the row with the title in question. 

5. Click on the radial button next to the item’s title (located the 
top of the screen). 

6. In the Target area (located in the lower grid of the page), use 
the drop down menu to select Teacher as the target. 

7. Use Search By drop-down menu and the Search fi eld to 
narrow your search for the teacher the item(s) should be 
distributed to. 

8. Click on their name. The row highlights to orange.  (On the
right side of the page, the person’s current distribution history 
displays.  If they do not have an item distributed to them, a 
message stating No Books Assigned to..., displays.) 

9. Click on (Transfer) 

10. Click on the respective check box located within the grid’s rows
to select the desired item(s) or click on the box in the blue 
header to select all items within the grid to be transferred. 

11. Click on (Save). The message Successful Transfer! 
appears. 

12. Click on (Cancel) to return to the Teacher Distributions 
screen. 
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Practice Activity 

In pairs or in small groups read the following scenarios and answer the questions 
as best you can. 

1. A teacher walks into your ofce and asks you the names/titles of the 
books he has checked out to his account.  In the Teachers area, there 
are 3 ways you can access that requested information.  Can you list all 
three? 

2. One of the math teachers would like to have a student edition textbook 
checked out to her in addition to the teacher edition textbook she 
would normally get.  How do you reflect the transaction in TIPWeb-
IM? 

3. A teacher, Susan Jameson, calls you and says she lent a book to a 
student.  The student, Eric Woods, says he lost it at the local mall.  Ms. 
Jameson wants the student to be held accountable for this book’s 
loss.  The book’s accession number is 2101977.  How do you refl ect the 
transaction in TIPWeb-IM? 
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Practice Activity 

In pairs or in small groups unscramble the words listed below. 
Then create a sentence using all of the words in the scramble. 

echrtae _______________________________________________________________ 

itubdestir _____________________________________________________________ 

caecsisno _____________________________________________________________ 

fsnarert _______________________________________________________________ 

ncio __________________________________________________________________ 

tlcleco ________________________________________________________________ 

essssa gerahc _________________________________________________________ 

noitvangai rab ________________________________________________________ 

engahc ttsuas _________________________________________________________ 

chsera ________________________________________________________________ 

egsotar________________________________________________________________ 
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Find A Book 

Overview 

The Find A Book icon allows you to research instructional material 
distributions.  It is especially helpful with finding the person assigned to 
a missing/lost materials and collecting instructional materials. 

When you search by Accession, ISBN, Title, or SLC, the results are:

 • To whom the material was issued

 • The individual is identified as a student or a teacher

 • The accession number, status, and date of the transaction is 
displayed 

When selecting the Details tab after a search by ISBN, Title, or SLC, the 
results can be exported to a MS Excel spreadsheet. 

Did You 
know? 

With TIPWeb-IM, your 
accession numbers 
are unique within your 
entire district - not just 
your campus. 

So, if you find a book 
in the bleachers after 
a basketball game 
and your search by 
accession returns no 
results, you can choose 
to search by Accession 
(district wide). 

If the results indicate 
the book has been 
issued to a student/ 
teacher at another 
campus within the 
district you can contact 
the campus and let 
them know you will be 
returning the book to 
them. 
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Find A Book Screen 

Export to Excel icon  allows you to export Export Grid Data to 
Excel. 

Collect icon  returns the material to storage and changes the status
to CLTD (collected). 

Change Status icon  changes the status of material to either LOST
(lost), DSTY (destroyed), PAID (fully paid), PRTL (partial paid), or CLTD 
(return to storage). 

Assess a Charge icon  opens the Assess a Charge screen allowing
you to assess a charge for damage to the material(s). 

Details tab  displays the instructional material distribution
history by individual and accession number. 

Summary tab  displays the material(s) inventory summary. 

Find A Book: Introduction   
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Search by Accession 

1. Click on (Find A Book) on the Navigation Bar. 

2. Select Accession from the Search By drop-down menu. 

3. Enter the accession number you wish to research into the 
Search text box. 

4. The information displayed provides you with: 
• The ID and name of the individual that is responsible

for the item 
• Information on whether the individual is a student or 

teacher 
• The accession number 
• The status of the item 
• The date the transaction occurred 

Did you know? 

If you search by ISBN, Title or SLC, you have the 
option to export the results to Excel.  This allows 
you to reformat the data to fit your needs. 
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Practice Activity 

In pairs or in small groups read the following scenarios and answer the questions 
as best you can. 

1. Using your TIPWeb-IM Training Worksheet, search for one of the 
accession numbers you have used in today’s session. 

2. If a textbook was found on the visitor’s side of the gym last night 
(which held the big basketball game between your school and your in 
district rival), how would you go about finding out to whom this book 
might belong? 

3. A teacher found a textbook which had fallen behind a file cabinet. 
Using Find A Book and searching by accession number, the book 
shows two people attached to this accession number.  One record 
shows the teacher who found the book with a status of XFER. The 
other  record is a student with a status of DIST. What does this mean? 
How do you properly record the book’s return to the bookroom? 
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Overview 

Other Data consists of three components: 

1. Vendor/Publisher area allows you to: 

► Create a database of vendors from which you 
purchase textbooks or materials  

► Link your items to the vendor who provides those 
items to you 

► Store your contact names and phone numbers 

For the items included in the Master Titles list, TIPWeb-IM provides 
you with a list of publishers assigned to those items. You only need to 
fill in the contact information for each of those publishers. 

2. Courses area allows you to: 

See which students and teachers have been assigned to the course.  
Course, student and teacher information is imported on a regular 
basis from your Student Information System.  Additionally you can 
assign instructional materials to the course.  The process of assigning 
instructional materials to courses is typically done for you by the 
district level textbook staf . 

3. View Archives area is comprised of records archived during the  
year end Closing process. 

This allows you to view instructional material transactions previously 
assigned to students or teachers, which you archived through 
TIPWeb-IM’s Closing process.  The View Archives area allows you 
to search for and view archived records of: 

► Students 

► Teachers 

To learn more about closing records, go to Closing, located 
under the Tools category. 
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Vendors/Publishers Screen 

Did you 
know? 

You can edit the 
following: 

• Name 
• Account # 
• Contact 
• Address 

Vendors/Publishers: Introduction 

• City 
• State 
• Zip 
• Phone 
• Email 
• Fax # 
• Notes 

The Notes field has no 
size limit. 

The ID is the only 
information you 
cannot edit. 
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Add a Vendor/Publisher 

1. Click on (Other Data) located on the Navigation Bar. 

2. Click on (Vendors/Publishers) 

3. Click on (Add). 

4. Insert Vendor/Publisher information in the appropriate fi elds. 

5. Click on (Save). 

6. If you are not sure, click on (Cancel). 

Edit a Vendor/Publisher 

1. Click on (Other Data) located on the Navigation Bar. 

2. Click on (Vendors/Publishers) 

3. Use Search to find the vendor/publisher you want to edit. 

4. Click on (Details) in the row listing the vendor/publisher 
name you want do edit. The Vendors/Publishers Details page
displays. 

5. In the center of the page, click on (Edit). 

6. Edit the vendor/publisher information. 

7. Click on (Save). The message You have successfully 
updated the vendor/publisher appears. 

8. Click on (Previous Page) to return to the Vendors/Publishers 
Details page. 
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Course Details Screen 
Courses Screen 

Courses: Introduction 

Did you 
know? 

The Courses 
area allows you 
to maintain 
courses and 
the relationship 
between courses 
and items. 

How is this 
information 
useful to you? 

You will be able to 
see students and 
teachers assigned 

Textbooks tab  allows you to assign instructional 
materials to the course.  This helps create accurate enrollment and 
textbook eligibility numbers. 

Students tab  displays the students’ names, 
periods, sections, and teachers assigned to the course. 

Teachers tab  displays the teachers’ names, periods,
and sections assigned to the course. 

to courses, and 
which teachers are 
teaching which 
course. You can 
also assign an 
item to the course 
and indicate the 
percentage of 
students that will 
be using the item. 
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1. Click on (Other Data) located on the Navigation Bar. 

2. Click on (Courses) 

3. Use Search for the course to which you want to add the item. 

4. Click on (Details) . 

5. Under the (Textbooks Tab), click on (Add 
Textbook). 

6. Use Search to find the item title to add to the course. 

7. Click in the Select box for the titles you want to add. 

8. Insert the student and/or teacher percentage for each title. 

9. Click on (Add Selected). 

10. To return to the Course Details screen of the course to which you just 
added items, click (Previous Page). 

Edit a Textbook Assigned to a Course 

1. Click on (Other Data) located on the Navigation Bar. 

2. Click on (Courses) 

3. Use Search for the course to which you want to make changes to the  
course book relationship. 

4. Click on (Details). 

5. Under the (Textbooks Tab), click on (Edit) in the
row listing the item you want to edit 

6. Make the desired changes to the eligibility percentages or delete the
relationship. 

7. Click on (Save), to save the changes or (Cancel), if you want  
to start over. 
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View Archives Screen 

View Archives: Introduction 

Did you 
know? 

Use View Archives 
to search the campus 
database for archived 
information on: 

•  Students 

•  Teachers 

Archived data 
includes records 
removed from 
student and teacher 
instructional 
materials history 
through TIPWeb-IM’s 
Closing process. 

Data will only be 
displayed in this area 
if you have completed 
the archiving processes 
found in TIPWeb-IM’s 
Closing area under 
Tools. 
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View Student Archives 

View Archives: Step by Step 

  

  

  

  

  

1. Click on (Other Data) located on the Navigation Bar. 

2. Click on (View Archives) 

3. Use the Select Report Category drop down menu to choose 
Students. 

4. Under Search for Students, use the Search By drop down menu 
to select how you will be searching for the student in question. 

5. Use Search field to enter the specific searchable data you have for 
this student. 

6. Click on (Refresh) to start a new search. 

7. Click (Previous Page) to return to the Other Data main page. 

View Teacher Archives 

1. Click on (Other Data) located on the Navigation Bar. 

2. Click on (View Archives) 

3. Use the Select Report Category drop down menu to choose 
Teachers. 

4. Under Search for Teachers, use the Search By drop down menu 
to select how you will be searching for the teacher in question. 

5. Use Search field to enter the specific searchable data you have for 
this teacher. 

6. Click on (Refresh) to start a new search. 

7. Click (Previous Page) to return to the Other Data main page. 
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Tools 

Overview 

The Tools area consists of two major components: 

• Textbook Tools allows you to make specifi c customizations 
for the instructional materials distributed and tracked within 
your district.  Because any changes you make in this area will 
be applied to all campuses and the district, you may want to 
contact the district level before making any changes or additions 
to these areas. 

Textbook Tools includes: 

•  Material Types 

•  Subject Areas 

•  Student Transfers 

•  Funding Sources

 • Global Tools allows you to make TIPWeb-IM changes for your 
campus version of TIPWeb-IM.  The changes you make within 
this area only afect your campus’ TIPWeb-IM settings (not your 
entire district’s TIPWeb-IM settings). 

Global Tools includes: 

• User Management (see Need to Know section) 
•  Form Letter Editor (see Need to Know section) 
•  Closing 
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Tools: Introduction 

Tools Screen 

Textbook Tools 

Create Material Types allows you 
to define new material types. 

Edit Existing Material Types 
allows you to alter the description of
existing material types. 

Student Transfers allows you to 
receive and/or view student transfers. 

Add Subject Areas allows you to 

Global Tools 

User Management  Add/edit 
campus users. 

Form Letter Editor  Create, edit, 
and personalize form letters. 

Closing  This option provides
all the steps needed to close out an
academic year or term. 
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add subjects and a description of the 
subject. 

Edit Subject Areas allows you to 
change subject information. 

Add Funding Source allows you 
to add the funding source and the 
description. 

Edit Funding Source allows you 
to change funding source information. 
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Material Types: Step-By-Step 

Create Material Types Screen 

1. Click on (Tools) located on the Navigation Bar. 

2. Under Textbook Tools subcategory, click on (Create 
Material Type) 

3. Name the new Material Type. 

4. Enter a description (optional) in the Description text box. 

5. To save, click on (Save). 

The message You have successfully added a new material 
type! displays. 

6. Click (Previous Page) to return to the Tools main page. 
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Subject Areas: Step by Step 

Create a Subject Area 

1. Click on (Tools) located on the Navigation Bar. 

2. Under Textbook Tools subcategory, click on (Add Subject 
Area) 

3. Name the new Subject Area. 

4. Enter a description (optional) in the Description text box. 

5. To save, click on (Save). 

The message You have successfully added a new subject area! 
displays. 

6. Click (Previous Page) to return to the Tools main page. 
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Funding Source: Step by Step 

Create a Funding Source 

1. Click on (Tools) located on the Navigation Bar. 

2. Under Textbook Tools subcategory, click on (Add Funding 
Source) 

3. Name the new Funding Source. 

4. Enter a description (optional) in the Description text box. 

5. To save, click on (Save). 

The message You have successfully added a new funding 
source! displays. 

6. Click (Previous Page) to return to the Tools main page. 
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Tools - Closing: Introduction 

STUDENT 

Change Student 
Distribution’s to Lost allows you 
to select a portion or all student
distributions and change them 
to lost.  Options to change the 
student distributions  are by Date, 
Title, and Grade. 

Remove/Archive Book 
History - Students allows 
you to remove current student
transaction book history data
and send it to your TIPWeb-IM 
archives.  This will remove and 
archive the data accumulated 
since the last time closing was 
performed. 

Remove/Archive Cleared 
Students allows you to remove
current cleared student account 
data and send it to the TIPWeb-
IM archives.  Cleared students are 
students with no material(s) on
their accounts.  This will remove 
and archive the data accumulated 
since the last time closing was 
performed. 

TEACHER 

Change Teacher 
Distribution’s to Lost allows you 
to select a portion or all of the 
teacher distributions and change
them to Lost.  Options to change
teacher distributions are by Date 
and Title. 

Remove/Archive Book 
History - Teachers allows you 
to remove your current teacher 
transaction book history data and 
send it to the TIPWeb-IM archives. 
This will remove and archive the 
data accumulated since the last 
time closing was performed. 

Remove/Archive Cleared 
Teachers allows you to remove
current cleared teacher account 
data and send it to the TIPWeb-
IM archives.  Cleared teachers are  
teachers with no materials(s) on
their accounts.  This will remove 
and archive the data accumulated 
since the last time closing was 
performed. 
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Change Student 
Distributions to Lost: Introduction 

Cancel icon 
returns you to the 
Closing main page. 

Go icon  launches 
the settings you 
have selected on the 
Student Distributions 
to Lost screen. 

Did you 
know? 

This area allows you to 
globally change student 
Distributed materials 
to Lost. This is done at 
the end of a term and/ 
or the end of the school 
year. 

Remember:  To aide in 
your collection ef orts, 
changing student 
distributions to a Lost 
status allows you to 
print and mail letters 
to those students with 
distributed instructional 
materials. 
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Change Student Distributions to “Lost” 

1. Click on (Tools) located on the Navigation Bar. 

2. Under Global Tools subcategory, click on Closing. 

3. Under the Student subcategory, click on Change Student 
Distributions to Lost. 

Change Student 
Distributions to Lost: Step by Step 
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4. Use one of the three tabs, (Date, Title, Grade) to limit the records
to be changed by the appropriate subject.  To select all records 
skip to #5. 

5. Click on  (Go). 

6. A pop-up window displays a confi rmation message: The following 
action will change all distributed books to Lost for your 
selections.  Are you sure?  If you are ready to perform this step, 
click the OK button. 

7. The processing screen below will appear while the database is
working. 

8. A pop-up window displays the message, Success! Processing is 
complete. Closing transaction has been completed. Click the 
OK button. 

9. Click on the (Cancel) to return to the main Closing screen. 
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Remove/Archive Book 
History - Students: Introduction 

Remove & Archive Collected Transactions removes Collected 
student transaction book history currently on a student record
respective to the date settings you select and sends it to your TIPWeb-
IM archives.  You have the option to remove and archive Collected 
student transactions three ways:

 • between two specific dates of your choosing
 • prior to a date of your choosing
 • all dates within the TIPWeb-IM database  (recommended

when preparing the database for a new school year) 

Remove & Archive Reconciled Paid/Partial Paid Transactions 
removes all reconciled Paid and/or Partial Paid student transactions
currently on a student account and sends it to your TIPWeb-IM 
archives.  You have the option to remove and archive Paid and Partial 
Paid student transactions two ways:

 • between two specific dates of your choosing
 • when preparing the database for a new school year, it is

recommended to remove and archive Paid and Partial Paid records 
which are older than one or more years. 

Remove & Archive Reconciled Lost Transactions removes all 
reconciled Lost student transactions currently on a student account 
and sends it to your TIPWeb-IM archives.  You have the option to 
remove and archive Lost student transactions two ways:

 • between two specific dates of your choosing
 • when preparing the database for a new school year, it is

recommended to remove and archive Paid and Partial Paid 
records which are older than one or more years. 

Cancel icon  returns you to the Closing main page. 

Did you 
know? 

The primary purpose of 
removing and archiving 
student book history  is 
to remove old records 
from the current student 
record for which they are 
no longer responsible (for 
example: collections, full 
payments, etc...). 

This allows you to print 
student receipts and 
reports displaying current 
year transactions only.  

What does 
reconciled 
mean? 
A reconciled record 
(which could be in an
individual’s distribution 
status as Paid, Partial 
Paid, or Lost) is an item 
for which the campus has 
paid the district. 

This payment is noted 
and a reconcilled record is 
created when the district 
posts a Paid campus
adjustment request. 
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Remove/Archive Student Book History 

Remove/Archive Book 
History - Students: Step by Step 

1. Click on (Tools) located on the Navigation Bar. 

2. Under Global Tools subcategory, click on Closing. 

3. Under the Student subcategory, click on Remove/ 
Archive Book History - Students. T T

o
o

ls
 

4. Select the types of student transactions to remove from 
the current student records and send to your TIPWeb-IM 
Archives (see detailed information regarding the transaction 
types on previous page). 

5. Identify the dates from which you wish to remove the 
selected student transactions (see information regarding the 
date options on previous page). 

6. Select the red “I agree that once this process begins” 
statement. The (Begin Archiving) icon will appear. 

7. To archive the selected transactions, click on (Begin 
Archiving). 

8. The processing screen below will appear while the database is
working.  It looks like this: 

9. A pop-up window informs you that the process was a 
success. Click (OK) and you will be returned to the main 
closing screen. 
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Cancel icon 
returns you to the 
Closing main page. 

Go icon 
launches the settings
you have selected on
the Remove/Archive
Cleared Students 
screen. 

Remove/Archive 
Cleared Students: Introduction 

Remove/Archive 
Cleared Students: Step by Step 

1. Click on (Tools) located on the Navigation Bar. 

2. Under Global Tools subcategory, click on Closing. 

3. Under the Student subcategory, click on Remove/Archive Cleared 
Students. 

4. To limit the search to specific grade level, use the  tab, choose 
the respective grade from the drop-down menu, and click on  (Go). 

5. To archive ALL cleared students, click on  (Go). 

6. The processing screen below will appear while the database is working. 

7. A pop-up window informs you that the process was a success. Click the 
OK button. 
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Teacher Distributions to Lost: 
Introduction 

Cancel icon  returns you to 
the Closing main page. 

Go icon  launches the 
settings you have selected on
the Teacher Distributions to 
Lost screen. 
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Teacher  Distributions to Lost: 
Step by Step 

1. Click on (Tools) located on the Navigation Bar. 

2. Under Global Tools subcategory, click on Closing. 

3. Under the Teacher subcategory, click on Change Teacher 
Distributions to Lost. 

4. To limit the search to specific items that need to be changed from 
Distributed to Lost, use one of the two tabs (Date and Title). 

5. Select the date or title for which you want to change the status or 
simply click on  (Go) to change all the records. 

6. A pop-up window displays a confi rmation message: The following 
action will change all distributed books to Lost for your 
selections.  Are you sure?  If you are, click the OK button. 

7. The processing screen below will appear while the database is
working. 

8. A pop-up window displays the message, Success! Teacher 
distribution records updated. Click the OK button. 

9. Click on the (Previous Page) to return to the main Closing 
screen. 

Did you 
know? 

You may choose NOT 
to run this part of the 
Closing process. 

Many campuses 
choose to allow their 
teachers to retain their 
distributions from year 
to year.  If your campus 
has the same policy, 
skip this part of the 
Closing process for 
your teachers. 

Should you run this or 
not? 

If you are not sure, 
contact the Hayes 
Customer Support 
Team.  They will happily 
help you decide which 
Closing processes are 
best to run for your 
campus. 
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Remove/Archive Book 
History - Teachers: Introduction 

Cancel icon 
returns you to the 
Closing main page. 

Go icon  launches 
the removal and 
archiving of all 
collected instructional 
materials from ALL 
teachers. 

Remove/Archive Book 
History - Teachers: Step by Step 

1. Click on (Tools) located on the Navigation Bar. 

2. Under Global Tools subcategory, click on Closing. 

3. Under the Teacher subcategory, click on Remove/Archive 
Book History - Teachers. 

4. To archive ALL collected items and transactions, click on (Go). 

5. The processing screen below will appear while the database is
working. 

6. A pop-up window informs you that the process was a success. 
Click the OK button. 
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Remove/Archive 
Cleared Teachers: Introduction 

Cancel icon 
returns you to the 
Closing main page. 

Go icon  launches 
the settings you 
have selected on 
the Remove/Archive
Cleared Teachers 
screen. 

Remove/Archive 
Cleared Teachers: Step by Step 

1. Click on (Tools) located on the Navigation Bar. 

2. Under Global Tools subcategory, click on Closing. 

3. Under the Teacher subcategory, click on Remove/Archive 
Cleared Teachers. 

4. To archive ALL cleared teachers, click on  (Go). 

5. The processing screen below will appear while the database is 
working. 

6. A pop-up window informs you that the process was a success. 
Click the OK button. 
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Inventory: Campus Transfers 

Overview 

TIPWeb-IM provides a function that allows campus-
to-campus transfers to be initiated at the campus 
level. 

Check with your district ofce to see if you are 
allowed to use this TIPWeb-IM function.  The district 
can allow this function with a setting in the District 
View of TIPWeb-IM. 

Campus-to-campus transfer means you can request, 
receive, and send instructional materials directly 
from/to another campus within your district. You can 
also edit campus transfers to your needs. M 
The instructions in this section assume that your 
district has allowed for campus-initiated campus-to-
campus transfers. 
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Did you know? 

On the TIPWeb-IM Home page, under the Alerts 
subcategory, are some alerts which are meant to inform you 
about campus-to-campus transfers. 

Click on either Pending Transfer Requests or Transfers 
in Transit to go directly to the (Transfer Request) page,
regardless of text color. 
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  Campus Transfers: Step by Step 

Request Items from Another Campus 

1. Click on (Inventory) on the Navigation Bar. 

2. Under the Transfers subcategory, click on Campus Transfers. 

3. Click on (Add New). 

3

4. Choose the Request Textbooks option. 

5. Click on (Next). 

4
5

6. Use Search to find the item to request and click on its title (the 
inventory summary for this item appears at the bottom of the screen). 

7. Click on (Add Book to Transfer Request). 

6

7
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8. The district-wide inventory/eligibility page for the requested item 

10

9

opens and displays the inventory and eligibility for each campus 
in the district. 

9. Enter the amount of items requested in the Qty to Transfer 
field of the row corresponding to the campus from which you 
want to request items. 

10. Click on (Add Entered Quantities to Transfer). 

11. If you want to request additional titles from any campus in the 
district, follow steps 6 through 9. 

12. To finalize the campus transfer request, click on (Save). M 
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Inventory: Audits 

Overview 

The Audits area allows you to complete district requested 
audits of your campus’ district tracked inventory.  You have 
the ability to enter quantities, submit your audit to the district 
electronically, and print an audit report. 

Audits Screens 

Hayes Software Systems 124 Ask Our Customer Support Team!  800-495-5993 



  

 
  

 
 

  

M 

Complete the Audit 

Audits: Step by Step 

1. Click on (Inventory) located on the Navigation Bar. 

2. Under the Audits subcategory, select Audit Management. 

3. Click on (Edit) in the corresponding audit row. 

4. Search for the item you wish to enter the quantity for or begin 
inserting counts beginning at the top of the list. (The default sort
for the list is SLC.  You can click on any of the grid headers to sort 
the list by the selected header.) 

5. Enter a quantity in the respective Quantity Field. 

6. Click on (Add counts) to begin creating your “counted list” 
in the bottom grid. (Your added quantities will move from  the 
upper grid to the lower grid’) 

7. Click on (Submit) once the top grid displays “No Records to 
Display.” 

M
is

ce
ll

a
n

eo
u

s

8. Confirm the audit submission by entering a digital signature.  This 
includes entering a person’s Full Name and their Initials. 

9. Click on Sign and Submit. This returns you to the Audit 
Management page. 

5

4

7 6
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Audits: Step by Step 

Edit an “In Progress” Audit 

If you find more materials in the far back corner of a closet, after you have
entered quantities for all of your items, you can edit the current audit 
while it is in the status of “In Progress.” 

1. Click on (Inventory) located on the Navigation Bar. 

2. Under the Audits subcategory, select Audit Management. 

3. Click on (Edit) in the corresponding audit row. 

4. Search for the item you wish to edit the quantity.  It will be 
displayed in the lower grid. 

5. Click on (Edit) in the corresponding audit row.  The Edit 
Audit Count window will appear. 

6. Enter the number of items found.  If the original count should be
less, enter the quantity preceded by a minus (–) sign. 

7. Click on (Save). This updates the ISBN audit Count and 
returns you to the Edit Campus Audit page. 

8. Repeat steps 4 through 7 to edit additional ISBN counts. 

9. Click on the (Previous Page) to return to the main Campus 
Audit Management screen. 

Did you 
know? 

The title may also be 
removed from the lower 
grid by clicking on the   

(Delete). 

This returns the title to 
the upper grid and allows 
you to re-enter a new 
beginning count. 
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Textbooks: Add Textbook Image 

Overview 

TIPWeb-IM provides you with the option to add an image to every 
instructional material in your inventory to further assist you in 
identifying items more easily. 

To add an image to a title you must first save the image fi le (either 
.jpg or .gif) to a location on your computer.  You can do this by either 
searching the Internet for the specific title and download the image 
for it to your PC, or by scanning the image from a specific item your 
campus owns. 

Once you upload the image for a specific item, it resides permanently 
in the TIPWeb-IM database and is automatically available to all other 
campuses within your district. M 
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Add Textbook Image: Introduction 
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Add Textbook Image: Step by Step 

Add a Textbook Image to a Title 

1. Click on (Textbooks) located on Navigation Bar. 

2. Use Search to find the item to which you want to add an image. 

3. Click on (Details) in the row that lists the item to which you 
want to add an image. The Textbook Details page opens. 

4. Click on (Add Image) as shown in the following 
screen capture. 

5. The Upload Textbook Image dialog box opens as shown in the 
following screen capture. 

6. Click on Browse to find the image you want to upload. The image 
you are about to upload is automatically set as the default image 
for the specific item you chose. 

If that is what you want, leave the Use this as the default image? 
check box selected. 

Otherwise, click the Use this as the default image? check box to 
deselect it. 

7. Click OK. 

Did you 
know? 

To find an image of the 
textbook you have, run 
a search on the Internet 
(like Google or Bing) and/ 
or search the respective 
publisher’s website.  You 
will find something similar 
to the image below: 

After finding the desired 
image, right click over 
the image and choose 
the Save Picture As 
menu option.  Make 
sure you save the image 
in a location you will 
remember (on your 
computer, thumb drive 
or server).  Feel free to 
rename the image’s fi le 
name to help remind you 
which image it is for. 
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TIPWeb-IM’s Search 
Functionality 

Searching for the desired information could be a daunting task if you were 
asked to find a needle in a haystack. TIPWeb-IM takes that needle and makes 
it very easy for you to find it. Even if you only have one piece of information 
about that needle, TIPWeb-IM allows you to locate it in just a matter of 
seconds. 

For every function within TIPWeb-IM that contains a list of persons or items, a 
search can be performed. You will see Search for and Search by. The Search Mby will be diferent depending upon the type of information for which you are 
searching. In many cases, an All preference can be selected. This is extremely 
powerful. 

Regardless of what piece of information you have pertaining to a book, 
student, teacher, or item, you can search by All. 

For instance, if you are searching in Students and know the last name of 
the student, you can search by All and type in Connor. The 
results will display all students for which Connor is their last 
name or their fi rst name. 

Perform a Search 

1. Select the Search By field using the drop-down menu. 

2. Enter the search information in the Search fi eld. 

3. Click on (Execute Search) or press Enter on your keyboard. 

4. To reset the criteria to perform another search, click on (Reset). 
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Report Samples 

District Provided:  Call Tag 

Call Tags are printed by the district ofce after 
a Campus Adjustment has been submitted. 
The district will commonly send a district level 
staf member with a Call Tag to pick up the
instructional materials listed on the Call Tag. 

Return Surplus Campus Adjustments are the 
most common Campus Adjustments which will 
require a Call Tag to be printed. Return Surplus 
Campus Adjustments mean your campus has 

an excess of a certain instructional material and 
you would like it shipped to the warehouse or the 
district level has a need for it elsewhere. 

Look for Call Tags from your district ofce 
for Worn and Return Surplus Campus 
Adjustments. 

Pick Up From 
Ship ToDixon Elementary12345 Education Way 

Shawn Carlson

512-219-7906

Austin TX 78726

11910 Volente Rd

Learning ISD 

Jason Long

512-546-1123 

Campus Name 
Adjustment Name 

Created By Type 

Dixon Elementary 
EOY Surplus 09 

Debbie Disler Return
SurplusSLC ISBN 

Title 
Copies Picked Up Price Amount 

4120 1570395039 

$6.00
5

$30.00 

EDM Journal 1, Grade 46120 1570395136 

$6.00
3 

$18.00 

EDM Journal 1, Grade 64120 1570395047 

$6.00
5 

$30.00 

EDM Journal 2, Grade 46120 1570395144 

$6.00
3 

$18.00 

EDM Journal 2, Grade 6 

$96.00 

Call Tag 

Campus Signature 
Driver Signature 

Page 1 of 1 

1234 Education Way
Austin, TX 78726 
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District Provided: 
Campus Transaction Report 

The report lists, by campus, the textbooks 
requisitioned by the campus and collected 
from the campus by the district. The type of 
transaction reflects any reassignment of copies. 
Titles are listed in ISBN order, displaying the: 

The total number of copies in use by the 
campus is displayed under each title with the 
total dollar value. 

• Transaction reference 
• Date 
• Type of transaction 

Hayes Software Systems Ask Our Customer Support Team!  800-495-5993 132 

Learning ISD 

Campus Transaction Report

Friday, January 01, 2010 

001 

Learning High School 
Shawn Carlson 

SLC 
ISBN 

Price 

Publisher/Vendor 

Title 

$32.00 

0022780998 McGraw-Hill Science, Gr. 4 

McGraw-Hill School Division 

4200 

Transaction Reference 

Date 
Type 

Copies 

GROWTH 07 
7/9/2007 9:45:45 AM Distributed 

40 

RETURN TO WAREHOUSE SCIENCE 
2/10/2008 7:10:45 PM Returned 

-12 

SLC 
ISBN 

Price 

Publisher/Vendor 

Title 

$8.72 

0022814841 5th Health Your Body Book 

McGraw-Hill School Division 

57HO 

Transaction Reference 

Date 
Type 

Copies 

001 INITIAL LOCAL INVENTORY 
2/3/2008 9:55:03 PM Distributed 

100 

SLC 
ISBN 

Price 

Publisher/Vendor 

Title 

$40.00 

0022819401 Macmillan/McGraw-Hill Health and Wellness 5th Grade McGraw-Hill School Division 

57H0 

Transaction Reference 

Date 
Type 

Copies 

001 Campus Initialization Distributions 
1/31/2008 9:16:02 AM Distributed 

1 

SLC 
ISBN 

Price 

Publisher/Vendor 

Title 

$40.00 

002636378X Glencoe French 3: En voyage 

Glencoe / McGraw-Hill 

9423 

Transaction Reference 

Date 
Type 

Copies 

ENROLLMENT INCREASE LHS 
7/17/2007 12:37:35 PM Distributed 

5 

SLC 
ISBN 

Price 

Publisher/Vendor 

Title 

$34.80 

0026759209 Family Health 

Glencoe / McGraw-Hill 

9526 

ID 

Campus Name 

Contact 
Region 

Total: 

Value: 
896 

28 

Total: 

Value: 
872 

100 

Total: 

Value: 
40 

1 

Total: 

Value: 
200 

5 

1 61
Page 

of 

• Number of copies af ected 



  District Provided: 
Pick Ticket 
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Notes:

9381B AP Psychology - Braille in 46 Volumes

B0534507204
ISBN

Notes:

Owned

Notes:

9381B AP Psychology - Braille in 46 Volumes

B0534507204
ISBN

Notes:

Audit Reports 

The 2 types of audit reports, as made 
available per audit by the district, are: 

• Owned count report - This will 
allow the campus to see the 
over/short counts. 

• “Blind” audit report - This 
means the campus will not see 
the owned inventory count the 
district expects the campus 
to locate. The over/short 
calculation will also not be 
displayed. 

Campus Audit Worksheet
Wednesday, February 29, 2012 

Status: Submitted
Submitted By: Debbie Disler

Date Submitted: Thursday, June 28, 2012 

Learning High School

Due Date: Friday, July 13, 2012 

Notes: 

Last Modified Date: Monday, December 12, 2011 

9152B Algebra 2 - Braille in 61 volumes 
Glencoe / McGraw-Hill $1,273.48 

B0078738318
ISBN 

Notes: 

Audit CountOwned New Count Over/Short 

1
0

1 

9241LP Prentice Hall Biology - Large Print in 5 volumes 

1 

Prentice Hall Publishing / Pearson Learning $500.00 

LP0131152912
ISBN 

Notes: 

Audit CountOwned New Count Over/Short 

1
0

1 

9251B Addison Wesley Chemistry - Braille in 68 volumes Addison Wesley / Pearson Education $1,293.00 

B0130580570
ISBN 

Audit CountOwned New Count Over/Short 

1
0

1 

Bedford, Freeman & Worth $1,500.00 

Audit Count New Count Over/Short 

1
0 

Title
SLC 

Publisher Price 

Page 1 of 2 

OOwned 

1 

Campus Audit Worksheet

Wednesday, February 29, 2012 

Status: In Progress

Submitted By:

Date Submitted: 

Charles Bailey High School

Due Date: Friday, January 20, 2012 

Notes: 

Last Modified Date: Sunday, December 11, 2011 

3230 3rd grade Harcourt Horizons - Large Print in 2 volumes 
Harcourt Brace & Company $101.42 

LP0153342307
ISBN 

Notes: 

Audit CountOwned 
New Count Over/Short 

0Hidden 

4320LP 4th grade Harcourt Horizons - Large Print in 2 volume 
Harcourt Brace School Publishers $0.64 

LP0153201819
ISBN 

Notes: 

Audit CountOwned 
New Count Over/Short 

0Hidden 

7451 Ya Veras! Lvl 1, Students Text 
Heinle & Heinle / Thomson Learning $40.00 

083846176X
ISBN 

Notes: 

Audit CountOwned 
New Count Over/Short 

185Hidden 

7452 Ya Veras! Lvl 2, Students Text 
Heinle & Heinle / Thomson Learning $40.00 

0838461778
ISBN 

Notes: 

Audit CountOwned 
New Count Over/Short 

200Hidden 

8120 Glencoe Pre-Algebra: Int. Trans. Alg. & Geometry TX, Gr. 8 Glencoe/McGraw-Hill Division(Contract Vendor) $40.50 

0028332423
ISBN 

Notes: 

Audit CountOwned 
New Count Over/Short 

50Hidden 

Title
SLC 

Publisher Price 

Page 1 of 30 
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121032 

Reports Helpful 
With Textbook 
Accountability 

Learning High School
Teacher Classroom Set Worksheet

Friday, January 01, 2010NILAY ADCOCKTeacher: 
SLC 

PricePublisher
Title

ISBN 

94G1 

$53.00
Holt, Rinehart and Winston /

Harcourt 

Holt German 1, Komm mit!
0030372542 

Accession StudentID Student Name 
Student Signature121021 

121022 
121023 
121024 
121025 
121026 
121027 
121028 
121029 
121030 
121031 

Total Copies: 
$1,590.00
30

Total Value: 

Page of1 136 

121032 
121033 

Learning High School
Class Roster Book CheckFriday, January 01, 2010 

Class Roster Book CheckFriday, January 01, 2010
Course ID 

Course Name4110 
W GEOSection

22 
SLC ISBN 

Title 
Price

9311 0618184244 
World Geography 

$60.24Student ID Name Accession Status 

Period 

861237 
3165654

TIFFANY A ADKISON 
Distributed 

02 

848048 
3011915

THERESA M BRUETTE 
Distributed 

02 

842965 
3010756

AMANDA J CHANDLER 
Distributed 

02 

861850 
3023127

ERICA R DRAKE 
Distributed 

02 

862174 
3011827

KEMBERLEY J FORD 
Distributed 

02 

842730 
3022907

SANDRA HERNANDEZ 
Distributed 

02 

823570 
3012515

EDGAR D KARKOS 
Distributed 

02 

825085 
3010547

SU Y KIEKE 
Distributed 

02 

822546 
3009949

JARL C KOHLER 
Distributed 

02 

821682 
3012059

CASEY N MOY 
Distributed 

02 

841495 
3010555

ALEXA D NADEAU 
Distributed 

02 

842776 
3023044

DYLAN T PASCHALL 
Distributed 

02 

821209 
3012256

LEAH ROY 
Distributed 

02 

846416 
3109277

JORDAN E UBANOSKI 
Distributed 

02 

832422 
3012601

SCARLETT J WEAVER 
Distributed 

02 
Section

32 
SLC ISBN 

Title 
Price

9311 0618184244 
World Geography 

$60.24Student ID 
Name Accession Status 

Period 

860883 
3164312

KRISTIN M ABBOTT 
Distributed 

03 

862755 
3114649

Lindsey BARASCH 
Distributed 

03 

851834 
3010918

CORINA COFFEE 
Distributed 

03 

846821 
3109100

LUCIA HAJOVSKY 
Distributed 

03 

843336 
3010658

BRITTANY M KENDALL 
Distributed 

03 

861471 
3011756

JENNIFER L MATTHEWS 
Distributed 

03 

862195 
3022849

TRAVIS A WHEELER 
Distributed 

03 

842999 
3015616

STACY A YATES 
Distributed 

03 
Section

42 
SLC ISBN 

Title 
Price

9311 0618184244 
World Geography 

$60.24Student ID Name Accession Status 

Period 

JILL A VANDIVERTeacher: 

The 3 reports displayed are: 

• Teacher Classroom 
Set Worksheet 

• Class Roster Book Check 

• Campus Distribution 
by Title Report 

 

 

 

121033
121034
121035
121036
121037
121038
121039
121040
121041
121042
121043
121044
121045
121046
121047
121048
121049
121050

121034
121035
121036
121037
121038
121039
121040
121041
121042
121043
121044
121045
121046
121047
121048
121049
121050
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Campus Distribution by Title Report 

Learning High School 

Campus Distribution by Title Report 

1/1/2010 10:56:05 PM 

9361 0321093364 

Pearson Education, Inc. $59.97 59 

Government in America 

Student ID 

Accession
Status

Date 
Student Name 

ADRIANA BAIRD
815849 

1311077
08/29/2006 DIST 

JONATHAN CROVO
831848 

3163860
09/05/2006 DIST 

KENDALL DARNELL
847873 

3163803
09/11/2006 DIST 

PAISLEY ELARMS
829649 

3163859
09/11/2006 DIST 

BRIANA FRASER
861136 

3017100
09/13/2006 DIST 

DEREK GRIFFITH
857366 

3163791
09/11/2006 DIST 

QUINTON KAMINSKI
846018 

3017058
08/17/2006 DIST 

JASMINE KEENER
862167 

3017080
09/13/2006 DIST 

BRANDI LESLIE
815458 

1311051
02/01/2008 DIST 

WESLEY MARTIN
861590 

3017116
08/17/2006 DIST 

WADE MC GAREY
818767 

3017158
08/17/2006 DIST 

DANIELLE ORDONEZ
820641 

3163848
09/11/2006 DIST 

SEAN SLIGER
834352 

3017143
08/17/2006 DIST 

FRANCINE VASQUEZ
820816 

3017090
08/17/2006 DIST 

DAVID VILANO
819645 

3017056
08/17/2006 DIST 

RICHARD WADIWALLA
841501 

3163844
09/11/2006 DIST 

ROBERT WARWICK
847001 

3163801
09/11/2006 DIST 

9360 0130637009 

Pearson Education, Inc. $58.25 151 

Magruders American Government

(Texas Edition) 

Student ID 

Accession
Status

Date 
Student Name 

NICOLE BARTLETT
818397 

3013455
09/19/2006 DIST 

ANDREW BEHRMAN
843401 

3013586
08/18/2006 DIST 

DANIELLE BOYETTE
828545 

3013952
09/18/2006 DIST 

SARAH CAPPS
842892 

3013861
08/18/2006 DIST 

LEAH DAUGHERTY
823550 

3013537
08/18/2006 DIST 

PAIGE DEVLIN
818428 

3017392
08/23/2006 DIST 

JENNIFER EASLEY
842919 

3013266
09/15/2006 DIST 

JESUS ELY
862002 

3013579
08/18/2006 DIST 

TYLER FONTAINE
818425 

3017376
08/22/2006 DIST 

TYLER FOWKES
842619 

3024926
09/15/2006 DIST 

HEATHER GARLAND
830026 

3013273
08/17/2006 DIST 

RACHEL GEORGIEFSKI
847797 

3006892
08/21/2006 DIST 

SAMANTHA GREGORIO
818607 

3013342
08/18/2006 DIST 

FALLON HARDY
818756 

3150672
08/16/2006 DIST 

KEN FRANCES JACKSON

846898-T1 

3150674
08/18/2006 DIST 

CODY JOHNSON
828124 

3024625
09/15/2006 DIST 

CLIFFORD JOHNSON
847517 

3013590
08/18/2006 DIST 

ARIEL MENDOZA
847194 

3013774
09/18/2006 DIST 

SLC ISBN 

Publisher 
Price Storage 

Title 

Page of1 2 

DIST= Distributed, PRTL= Partial Payment, DSTY = Destroyed, CLTD = Collected, PAID = Paid, LOST = Lost 
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Learning High School 
Student Listing with Bar Codes 

Wednesday, December 09, 2009 

Student Name Student ID Student Name Student ID GINA ABBOTT 

DAVID N ACOSTA 887766 

861377 KRISTIN M ABBOTT 

KENDRA S ACOSTA 860883 

857113-T1 8 
LAUREN R ABBOTTLAUREN R ABBOTT LAUREN R ABBOTT 

Mason ACOSTA 846803 

Learning High School 862597 BRANDON C ABDELRAHIM Class Roster with Bar Codes MICHELLE L ACOSTA Friday, January 01, 2010 847638 

Teacher Name 857324 Course Name 8 KATHERINE D ABERLY Course ID JILL A VANDIVER Section Period 
RYAN E ACOSTA W GEO 

4110 861963 22 02 Student ID Bar Code Name CHRISTOPHER R 847099 84 
Grade ABEYWICKRAMA HomeRoom 861237 

TIFFANY A ADKISON SEAN M ACOSTA 12 851414 001 
848048 859704 85 THERESA M BRUETTE CRYSTAL  ABOSO 12 001 

TIFFANY L ACOSTA 842965 842965 829979 AMANDA J CHANDLER AMANDA J CHANDLER 
0909 003 861903 861 JASON I ABREU 861850 861850 

ERICAERICA R DRA R DRAKKEE ROBERT B ADAMCIK 11 003 11 
861140 

862174862174 
EMBERL KKEMBERLEY JEY J FORD FORD 861713 861 MARISSA J ACHEE 09 09 003 

842730 842730 JARED W ADAMS SASANDRANDRA  HERNA  HERNANDEZNDEZ 860990 
10 10 003 

850402 8504 823570823570 ASHLEY N ACKER EDGAR D KARKO EDGAR D KARKOSS 
09 09 003 NICHOLAS S ADCOCK 820719 825085 825085 

SU Y K SU Y KIIEKEKEE 
825084 12 8250 12 006 DANIELLE M ACOSTA 

822546822546 
JARL JARL  C KC KOOHLHLERER 853595 1111 004 

862748 862748 
STEVEN L Page 1 STEVEN L MA MAIDENIDEN of a age 124 1 

12 001 12 

831840 831840 
MARISA J MILLE MARISA J MILLERR 

10 10 003 
821682 821682 

SEY N MOY CACASEY N MOY 
12 003 12 

841495 841495 
AALLEXAEXA D NA D NADEADEAUU 

1212 003 
842776 842776 

N T PA DYLDYLAAN T PASCHASCHALLLL 
10 001 10 

821209 821209 
LELEAHAH  R  ROOYY 

0909 001 
852316 852316 

H S SA SASARARAH S SAYEGHYEGH 
1212 003 

846416 846416 
JJOORDARDAN E UBN E UBAANNOSKI OSKI 

12 12 003 

PagePage 1 of 5 

Reports With 
Barcodes 

support.hayessoft.com 137 TIPWeb-IM Campus Training Manual 

https://support.hayessoft.com


Annual TIPWeb-IM Activities Calendar 
JU

L
Y

 

Activity How To 
Receive new 
instructional materials. 

You should receive a Pick Ticket with your shipment(s).  Verify the number shipped against 
the number actually received.  Report any discrepancies to your District instructional 
materials coordinator. 

Prepare instructional materials for
distribution. 

Print out bar code labels if district level does not provide them. From: Automation > Print
ISBN and Accession labels. 

Schedule pick-up of out of adoption
instructional materials. 

Coordinate with district instructional materials coordinator for pick up of these instructional
materials. 

Return to warehouse books that will 
not be used in the new school year. 

Create a return surplus “Adjustment Request”. 

Send out letters for lost instructional 
materials. 

Edit or create - found in TIPWeb-IM under Tools > Form Letter.  Use the default or create 
your own. Print Form Letter for lost books – found in TIPWeb-IM under Reports > Form
Letters. 

A
U

G
 / S

E
P

T 
/ O

C
T

  
 

  

  

 

  
 

  

  
 

  
 

  
 

 

 
  

 
 

 

 

 

 
 

 

Activity How To 
Return surplus books to district as
needed or requested by district. 
Receive new 
instructional materials. 

Send out letters for lost instructional 
materials. 

Distribute instructional materials to 
students/teachers. 
Submit requisitions for supplemental
orders as needed. 

Create an Adjustment Request from:
Inventory > Adjustments > Adjustment Request. 
You should receive a Pick Ticket with your shipment(s). Verify the number shipped against
the number actually received. Report any discrepancies to your District instructional
materials coordinator. 
Edit or create - found in TIPWeb-IM under Tools > Form Letter.  Use the default or create 
your own. Print Form Letter for lost books – found in TIPWeb-IM under Reports > Form
Letters. 

Distribute from: 
Automation > Quick Entry > Student Distribution or Teacher Distribution with Accession. 
Create a Campus Requisition from:
Inventory > Campus Requisition. 

N
O

V
 / 

D
E

C
 

Activity How To 
Conduct mid-year book check. Available reports for book checks include the Teacher Textbook Receipt, Class Roster Book 

Check and Student Textbook Receipt. 
Prepare PDA units. If using PDA units for distribution, charge them and conduct a test distribution prior to 

mass distribution.  Refer to the Keep Your Scanner Charged document on 
support.hayessoft.com 

Collect first semester instructional 
materials. 

Collect from: Automation > Quick Entry > Collect Accession.  
See support.hayessoft.com for Collection Best Practices.  

Change remaining fi rst semester
distributions to lost. 

From: Tools > Closing > Students > Change Distributions to Lost, select the Titles tab and 
locate each first semester book. 

Send out letters for lost fi rst semester 
books. 

Edit or create - found in TIPWeb-IM under Tools > Form Letter.  Use the default or create 
your own. Print Form Letter for lost books – found in TIPWeb-IM under Reports>Form 
Letters. 

Determine instructional materials 
requirements for 2nd semester. 

Once second semester schedules are active you can use the Campus Analysis of Need 
Report to determine the need for books. 

Submit requisitions for supplemental
orders as needed. 

Create a Campus Requisition from:
Inventory > Campus Requisition. 

Make adjustments as needed
for payments, destroyed or worn
textbooks. 

Create an Adjustment Request from: Inventory > Adjustments > Adjustment Request. 
Use the appropriate adjustment type. 

Hayes Software Systems 138 Ask Our Customer Support Team!  800-495-5993 



JA
N

 / 
F

E
B

Activity How To 

M
A

R
C

H
 / 

A
P

R
IL

 
 

 
 

 

 
 

 

  
 

  
 

 

 

 

 

 

 
  

 
 

  

 
 

   

 
 

  

  

 

   
      

yes

yes

yes

Receive new instructional materials. 

Send out letters for lost instructional materials. 

Submit requisitions for second semester orders. 
Make adjustments as needed. 

Conduct book checks and verify inventory
in preparation for annual orders (growth and
replacement). 
Mark books lost by students. 

You should receive a Pick Ticket with your shipment(s). Verify the number
shipped against the number actually received. Report any discrepancies to
your District instructional materials coordinator. 
Edit or create - found in TIPWeb-IM under Tools > Form Letter. Use the 
default or create your own. Print Form Letter for lost books – found in
TIPWeb-IM under Reports > Form Letters. 
Create a Campus Requisition from Inventory > Campus Requisition. 
Create an Adjustment Request from Inventory > Adjustments>Adjustment
Request. Use the appropriate adjustment type. 

Activity How To 
The week prior to your spring break is a good time to conduct a book check.
Available reports to distribute include the Teacher Textbook Receipt, Class
Roster Book Check and Student Textbook Receipt. 
Based on the book check mark books lost. From Students find and click on 
the student’s name. Select the Change Status icon for the corresponding
book. Change that status to lost. 

Send out letters for lost instructional materials. Edit or create-found in TIP under Tools>Form Letter. Use the default or create 
your own. Print Form Letter for lost books-found in TIP under Reports>Form
Letters. 

Make adjustments as needed. Create an Adjustment Request from Inventory > Adjustments > Adjustment
Request. Use the appropriate adjustment type. 

Submit requisitions for Annual order
(growth and replacement). 

Create a Campus Requisition from Inventory > Campus Requisition. 

M
A

Y
 / 

JU
N

E
 

Activity How To 
Conduct Final book check in early May. Available reports for book checks include the Teacher Textbook Receipt, Class

Roster Book Check and Student Textbook Receipt. 
Prepare PDA units. If using PDA units for collection, charge them and conduct a test collection prior to

mass collection. Refer to the Keep Your Scanner Charged document on support.support.
ha soft.comhayessoft.com 

Collect all distributed instructional materials from 
students/teachers. 

Begin collections as teachers indicate they are no longer using their instructional
materials. Collect from Automation>Quick Entry and select Collect Accessions. See
support.ha soft.comsupport.hayessoft.com for Collection Best Practices. 

Change all remaining distributions to lost. From Tools > Closing > Change Distributions to Lost.
Select Go to change all remaining distributions to lost. 

Return all instructional materials to the bookroom or 
designated locations for annual physical audit. Keep
out of adoption titles in a separate location. 

See support.ha soft.comsupport.hayessoft.com for Physical Audit Best Practices. 

Submit completed inventory audit to District by
prescribed deadline. 

Use Inventory > Audits or a Campus Inventory Taking Worksheet.
(See support.hayessoft.com for Physical Audit Best Practices.) 

Send out letters for lost instructional materials. Edit or create-found in TIP under Tools>Form Letter. Use the default or create your
own. Print Lost Book Form Letter-found inTIP under Reports>Form Letters. 

Send payment notice to teachers for any losses of
books for which they are responsible. 

Print out Teacher Textbook Receipt filtered by transaction type of lost. 

Designate personnel and location for receipt of annual
order shipments. 

The bulk of the annual order should begin arriving in July and continue through
September. 

Prepare out of adoption instructional materials for
pick-up by district. 

Box or palletize as prescribed by district personnel. 

Submit check for lost instructional materials to the 
accounting ofce. 

Every district handles this diferently. Some require full payment in June-others
expect a percentage of the total in June & the remainder after the school year begins. 

Return/Collect found “lost” books. Use Automation>Quick Entry>Collect Accession. 
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Resources 

Website Information 

California Department of Education Information 
Pertaining to instructional materials adoptions can be found at: 
www.cde.ca.gov/ci/cr/cf/ 

Georgia Department of Education Information 
Pertaining to recommended textbooks can be found at: 
www.doe.k12.ga.us/Curriculum-Instruction-and-Assessment/Curriculum-and-
Instruction/Pages/Learning-Resources.aspx 

Hayes Software Systems Information 
Regarding the Hayes Software System may be found at our website: 
www.hayessoft.com 

North Carolina Department of Education Information 
Pertaining to the textbook adoption services can be found at: 
www.ncpublicschools.org/textbook 

Tennessee Department of Education Information
For Textbook Adoption Coordinators can be found at: 
www.tennesseebook.com 

Instructional Materials Coordinators’ Association of Texas (IMCAT) 
This is a statewide organization that has been in existence since 1991. IMCAT works 
to inform the State Board of the implications of the changes they are suggesting as 
well to suggest changes that you have suggested. For more information on IMCAT 
visit their website at:  http://imcat.org 

Texas Education Agency Information 
Regarding the Texas Education Agency rules and regulations can be found at:  
http://tea.texas.gov/Curriculum_and_Instructional_Programs/Instructional_
Materials/ 

Used Textbook Companies 
Used textbook companies ofer textbooks at discounted prices.  Used books can be 
purchased to replenish lost inventory.  The following vendors may also buy your 
surplus materials: 

Follett Educational Services  800-621-4272, www.fes.follett.com 
Textbook Warehouse  800-796-9152, www.tbwarehouse.com 
Apple Textbooks  800-871-6162, www.appletextbooks.com 
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www.appletextbooks.com
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http://tea.texas.gov/Curriculum_and_Instructional_Programs/Instructional
http://imcat.org
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